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e-Learning
Altéa Administration Departure Plan Template 
As an administrator, discover how Amadeus helps you to manage your business operation activities and customise
them according to your markets.

On this course, you will learn:
>  What is Plan Template Management? Through a set of interactive e-Learning lessons, learn

how Altéa Administration organises markets using a
Template Tree, identifies operation activities for both
Flight Management and Customer Management, and
assign activities to templates to set up the departure
plan of a flight leg and for successful flight creation.

On this course, you will learn:
>  What is Plan Template Management?

Through a set of interactive e-Learning lessons, learn
how Altéa Administration organises markets using a
Template Tree, identifies operation activities for both
Flight Management and Customer Management, and
assign activities to templates to set up the departure
plan of a flight leg and for successful flight creation.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 20 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Operations Managers, Trainers

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM)   

How the course is organised
There is one mandatory e-Learning lesson. After completion,
there is an instructor-led session available to request an
enrolment. Finally, there are user guides available for
download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablette. 

> A high-speed internet connection (> 1MB). 

> The Google Chrome browser or alternatively the Microsoft
Edge browser. 

> An Amadeus login (LSS), organization ID (IATA code) and
password.   
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e-Learning
Altéa Administration Flight Management Business
Rules 
As an administrator, examine how Amadeus helps you to manage set of business rules to automate operational
processes so that manual intervention is not needed to optimise Altéa Departure Control - Flight Management (FM)
to align with your business goals.

On this course, you will learn:
> How to use markets to create Business Rules
> What is Flight Group Management?
> What are Rule Criteria Weights?
> What are Business Rules for Flight Management?
> What are Flight Create Business Rules?
> What are Active Flight Business Rules?
> What is Departure Plan Simulation?

Through a set of interactive e-Learning lessons, learn
how to use markets and flight groups to create
business rules, validate business rules for successful
flight creation and troubleshoot business rule errors
using Altéa Administration.

On this course, you will learn:
> How to use markets to create Business Rules
> What is Flight Group Management?
> What are Rule Criteria Weights?
> What are Business Rules for Flight Management?
> What are Flight Create Business Rules?
> What are Active Flight Business Rules?
> What is Departure Plan Simulation?

Through a set of interactive e-Learning lessons, learn
how to use markets and flight groups to create
business rules, validate business rules for successful
flight creation and troubleshoot business rule errors
using Altéa Administration.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Operations Managers, Trainers

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Flight Management (FM)   

How the course is organised
There are seven mandatory e-Learning lessons. After
completion, there is an instructor-led session available to
request an enrolment. Finally, there are user guides available
for download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablette. 

> A high-speed internet connection (> 1MB). 

> The Google Chrome browser or alternatively the Microsoft
Edge browser. 

> An Amadeus login (LSS), organization ID (IATA code) and
password.   
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e-Learning
Altéa Departure Control - Customer Management
As an agent, learn about automating key processes from customer acceptance to flight departure that streamlines
your activities for the best customer service.

In this e-Learning you will learn:
> How to get started
> What is the Altéa suite?
> How to complete customer acceptance tasks
> How to complete customer baggage and seating
tasks
> How to complete customer assistance and regrade
tasks
> How to complete boarding tasks
> How to complete disruption tasks

Using a set of simulations, learn how to accept
customers, manage special service requests (SSR),
modify flight itineraries, transfer customers and other
tasks with Altéa Departure Control - Customer
Management (CM). Each lesson is presented in a
sequence for you to complete, ending with a test
requiring a passing score of 100%. 

In this e-Learning you will learn:
> How to get started
> What is the Altéa suite?
> How to complete customer acceptance tasks
> How to complete customer baggage and seating
tasks
> How to complete customer assistance and regrade
tasks
> How to complete boarding tasks
> How to complete disruption tasks

Using a set of simulations, learn how to accept
customers, manage special service requests (SSR),
modify flight itineraries, transfer customers and other
tasks with Altéa Departure Control - Customer
Management (CM). Each lesson is presented in a
sequence for you to complete, ending with a test
requiring a passing score of 100%. 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 8 hours + 50 minutes English Awareness No No

Is this the course for you?
This course is for:
> Airline Program Managers.

> Departure Control System Project Members.

> Airline trainers.

> Airline check-in and gate agents.

 

 

This course helps you use
> Altéa Departure Control - Customer Management (CM)   

How the course is organised
First, there are forty-nine mandatory e-Learning lessons. After
completion, there is an online test. After passing the test, there
is an instructor-led session available to request enrolment.
Finally, there are user guides available for download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (< 1MB).

> The Google Chrome browser or alternatively the Microsoft
Internet Explorer browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password. 

The last few details...
> Last update: July 2021
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e-Learning
Altéa Departure Control - Flight Management
As a Load Controller, discover how Amadeus helps you to manage passengers and baggage, cargo, and fuel with
precision, to boost productivity in your load control operations. 

On this course, you will learn: 
> How Altéa Flight Management interacts with other
products
> How to navigate Flight Management
> How to add flight operating data
> How to navigate the Flight Information screen
> How to read messages, statuses and the Centre of
Gravity graph
> How to read the Joining Passengers display and
modify flight details
> How to identify an aircraft's weight, traffic load and
forecast zero fuel weight
> How to build a Dry Operating Weight and Index
> How to manage deadload for a flight
> How to manage the load distribution
> How to manage fuel for a flight
> How to manage passenger and baggage figures
> How to update load and ramp clear
> How to depart a flight

Through a set of interactive e-Learning lessons, learn
how Altéa Flight Management (FM) optimises load
planning for baggage and cargo, manages fuel
distribution, calculates the aircraft centre of gravity and
issues documents and messages for flight departure.

On this course, you will learn: 
> How Altéa Flight Management interacts with other
products
> How to navigate Flight Management
> How to add flight operating data
> How to navigate the Flight Information screen
> How to read messages, statuses and the Centre of
Gravity graph
> How to read the Joining Passengers display and
modify flight details
> How to identify an aircraft's weight, traffic load and
forecast zero fuel weight
> How to build a Dry Operating Weight and Index
> How to manage deadload for a flight
> How to manage the load distribution
> How to manage fuel for a flight
> How to manage passenger and baggage figures
> How to update load and ramp clear
> How to depart a flight

Through a set of interactive e-Learning lessons, learn
how Altéa Flight Management (FM) optimises load
planning for baggage and cargo, manages fuel
distribution, calculates the aircraft centre of gravity and
issues documents and messages for flight departure.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 hours + 30 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines, Ground Handlers

In particular, those working in:
Administrators, Air Traffic Control (ATC), Baggage Handlers,
Business & Projects Managers, Help Desk & Support Agents,
Load Controllers, Operations Managers, Trainers

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password

© 2026 Amadeus IT Group SA 10 amadeus.com



e-Learning
Altéa Departure Control - Operational Flight Updates 
As a ground handler, learn how to manage flight schedules for another airline when close to the departure date.

You will learn:
> How to create a flight date.
> How to create a flight period.
> How to update a flight date
> How to update a blockspace size.

Through a set of interactive videos learn how to
manage flight dates, flight periods and block space
using Altéa Departure Control - Operational Flight
Updates (OFU).

You will learn:
> How to create a flight date.
> How to create a flight period.
> How to update a flight date
> How to update a blockspace size.

Through a set of interactive videos learn how to
manage flight dates, flight periods and block space
using Altéa Departure Control - Operational Flight
Updates (OFU).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 40 minutes English Awareness Yes No

Is this the course for you?
This course is for:
> Staff performing ground handling activities.

Things you need for this course
Pre-requisite: 
> Basic knowledge of Altéa DC-CM or Altéa DC-FM.

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM)   

How the course is organised
There are four interactive lessons with a total duration of 40
minutes.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (< 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organisation ID (IATA or Ground
Handler code) and password. 

The last few details...
> Please note that access to this course is restricted
to Amadeus customers.
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e-Learning
Altéa Inventory
Through a set of interactive e-Learning lessons, learn how Altéa Inventory (INV) automates schedules and
re-accommodations, manages seating, handles special service requests and automates waitlist clearance.

On this course, you will learn:
> How to navigate Altéa Inventory
> How to install and log in to Altéa Inventory
> How Altéa Inventory works
> How Altéa Inventory works with other systems
> How to manage user access to Altéa Inventory
> How to work with Messenger
> What are Business Rules and markets?
> What are flight groups?
> How to get started with seating
> How to handle flight schedules
> How to handle re-accommodations
> How to read the flight date inventory panel
> How Altéa Inventory interacts with other products
> How the Altéa suite sends passenger information to a
departure control system
> How the Altéa suite receives passenger information
from a departure control system after flight departure
> How the Altéa suite sends passenger assistance lists
to another airport
> What is Schedule Loader?
> How to load new flight schedules
> How to update flight schedules
> How to manage codeshare flights
> What is Automatic Waitlist Clearance?
> How to manage Automatic SSR Handling
> How to set up automatic SSR handling replies
> How to set up automatic SSR handling replies with a
quota restriction
> How to set up automatic SSR handling replies
belonging to a SSR family
> How to set up automatic SSR handling replies without
a quota restriction
> What are Carrier Preferred Display service flows?
> How to get started with Revenue Integrity Desktop
> How to use the Revenue Integrity search engine
> How to use the rule editor to manage business rules
> How Amadeus Time Limits processes a PNR
> How to navigate Amadeus Time Limits screens
> How to create Amadeus Time Limits business rules
> What are the Amadeus Time Limits configurations?
> How to read Amadeus Time Limits logs
> How Group Time Limits processes a group PNR
> How to navigate Group Time Limits and set multiple
time limits

This course covers the following topics:
> Getting started with Altéa Inventory
> Creating Business Rules
> Exchanging information within Altéa
> Using Schedule Loader
> Discovering other Altéa Inventory features
> Managing Automatic Special Service Requests
> Using Carrier Preferred Display
> Using Amadeus Revenue Integrity

On this course, you will learn:
> How to navigate Altéa Inventory
> How to install and log in to Altéa Inventory
> How Altéa Inventory works
> How Altéa Inventory works with other systems
> How to manage user access to Altéa Inventory
> How to work with Messenger
> What are Business Rules and markets?
> What are flight groups?
> How to get started with seating
> How to handle flight schedules
> How to handle re-accommodations
> How to read the flight date inventory panel
> How Altéa Inventory interacts with other products
> How the Altéa suite sends passenger information to a
departure control system
> How the Altéa suite receives passenger information
from a departure control system after flight departure
> How the Altéa suite sends passenger assistance lists
to another airport
> What is Schedule Loader?
> How to load new flight schedules
> How to update flight schedules
> How to manage codeshare flights
> What is Automatic Waitlist Clearance?
> How to manage Automatic SSR Handling
> How to set up automatic SSR handling replies
> How to set up automatic SSR handling replies with a
quota restriction
> How to set up automatic SSR handling replies
belonging to a SSR family
> How to set up automatic SSR handling replies without
a quota restriction
> What are Carrier Preferred Display service flows?
> How to get started with Revenue Integrity Desktop
> How to use the Revenue Integrity search engine
> How to use the rule editor to manage business rules
> How Amadeus Time Limits processes a PNR
> How to navigate Amadeus Time Limits screens
> How to create Amadeus Time Limits business rules
> What are the Amadeus Time Limits configurations?
> How to read Amadeus Time Limits logs
> How Group Time Limits processes a group PNR
> How to navigate Group Time Limits and set multiple
time limits

This course covers the following topics:
> Getting started with Altéa Inventory
> Creating Business Rules
> Exchanging information within Altéa
> Using Schedule Loader
> Discovering other Altéa Inventory features
> Managing Automatic Special Service Requests
> Using Carrier Preferred Display
> Using Amadeus Revenue Integrity

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 6 hours English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Business & Projects Managers, Fare Filing
Agents, Help Desk & Support Agents, Inventory / Revenue
Managers, Load Controllers, Online Booking Engine Admin.,
Operations Managers, Planning and Dispatching Agents,
Reservation Agents, Sales & Marketing Agents, Security
Administrators, Space Controllers / SKD Managers, Ticketing
Agents, Trainers

This course helps you use
> Altéa Inventory and Code Share   

How the course is organised
There are three mandatory e-Learning lessons with thirty-eight
supplementary lessons. After completion, there is an online
test. After passing the test, there is an instructor-led session
available request for enrolment. Finally, there are user guides
available for download. 

 

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (< 1MB).

> The Google Chrome browser or alternatively the Microsoft
Internet Explorer browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password. 

The last few details...
> To schedule a Virtual or Classroom session, contact: 

learning@amadeus.com
> We recommend Inventory Managers and Schedule
Managers to attend 'Amadeus Altéa Inventory Certification' or
one of the two courses 'Amadeus Altéa Inventory: Inventory
Management Certification' or 'Amadeus Altéa Inventory:
Schedule Management Certification'.

> Last update: May 2021
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e-Learning
Altéa Reservation and Ticketing 
As a reservation agent, learn how to make reservations in the Amadeus Global Distribution System (GDS) using
cryptic commands.

You will learn:
> How to get started
> What is Amadeus Air?
> What are PNR Mandatory elements?
> What are PNR Optional elements?
> How to modify a PNR
> How to work with itineraries and invoices
> How to price and use fares
> How to use ticketing
> How to use Amadeus Queues

Through a set of interactive e-Learning videos learn
what is the Amadeus GDS and how to create and
modify the elements of a Passenger Name Records
(PNR) in order to issue a ticket using Altéa Reservation
(Cryptic).

You will learn:
> How to get started
> What is Amadeus Air?
> What are PNR Mandatory elements?
> What are PNR Optional elements?
> How to modify a PNR
> How to work with itineraries and invoices
> How to price and use fares
> How to use ticketing
> How to use Amadeus Queues

Through a set of interactive e-Learning videos learn
what is the Amadeus GDS and how to create and
modify the elements of a Passenger Name Records
(PNR) in order to issue a ticket using Altéa Reservation
(Cryptic).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 hours English Fundamentals No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Fare Filing Agents, Help Desk & Support
Agents, Inventory / Revenue Managers, Reservation Agents,
Ticketing Agents, Trainers

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW)   

How the course is organised
There are thirty mandatory e-Learning lessons with four
supplementary lessons. Also, there are user guides available
for download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Internet Explorer browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password. 
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e-Learning
Altéa Reservation Desktop Web awareness
As a reservation agent, process efficiently and swiftly passenger bookings and special requests, in any part of their
journey.

You will learn:
> What is ARD Web?
> How to navigate ARD Web.
> How to display a flight.
> How to find flight information.
> How to navigate PNR details.
> How to use fare display and informative pricing
search type.
> How to display and interpret an e-ticket record.
> How to display and interpret an EMD record.
> How to reissue e-ticket automatically (ATC).
> How to refund an e-ticket automatically (ATC).
> How to refund an EMD.
> How to display Sales Reports.

Through a set of interactive e-Learning, understand
what Altéa Reservation Desktop Web (ARD Web) is,
how to display flights and find its information, create a
Passenger Name Record (PNR) and sell ancillary
services, search for fares and price flights, issue and
exchange documents using ARD Web.

You will learn:
> What is ARD Web?
> How to navigate ARD Web.
> How to display a flight.
> How to find flight information.
> How to navigate PNR details.
> How to use fare display and informative pricing
search type.
> How to display and interpret an e-ticket record.
> How to display and interpret an EMD record.
> How to reissue e-ticket automatically (ATC).
> How to refund an e-ticket automatically (ATC).
> How to refund an EMD.
> How to display Sales Reports.

Through a set of interactive e-Learning, understand
what Altéa Reservation Desktop Web (ARD Web) is,
how to display flights and find its information, create a
Passenger Name Record (PNR) and sell ancillary
services, search for fares and price flights, issue and
exchange documents using ARD Web.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour + 10 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Fare Filing Agents, Help Desk & Support
Agents, Reservation Agents, Ticketing Agents, Trainers

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Altéa Reservation Desktop Web fundamental [e-Learning]   

How the course is organised
First, there are twelve mandatory e-Learning lessons. After
completion, there is a user guide available for download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop, or tablet.

> A high-speed internet connection (> 1MB).

> Google Chrome browser or alternatively the Microsoft Edge
browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

© 2026 Amadeus IT Group SA 14 amadeus.com
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e-Learning
Altéa Reservation Desktop Web fundamental
As a reservation agent, gain practical, step by step expertise in creating, copying and splitting PNRs, managing
ancillary and insurance services, and performing essential transactions, such as e ticket and EMD reissues,
refunds, and partial EMD payments using ARD Web.

In this course, you will learn how to:
> Create PNR with mandatory elements.
> Copy a PNR.
> Split a PNR and access associated PNRs.
> Create ancillary service and issue EMD using Ancillary
catalogue.
> Create ancillary service and issue EMD without the
Ancillary catalogue.
> Work with insurance services in a Passenger Name
Record (PNR).
> Reissue an e-ticket manually.
> Reissue an EMD.
> How to use an EMD partially and price a new e-ticket.
> How to refund an e-ticket manually.

Through a set of interactive lessons, learn how to
create, copy, and split a PNR and access associated
PNRs, create and issue EMDs with and without using
the ancillary catalogue, work with insurance services,
reissue EMDs and e-tickets, and manually refund
e-tickets.

In this course, you will learn how to:
> Create PNR with mandatory elements.
> Copy a PNR.
> Split a PNR and access associated PNRs.
> Create ancillary service and issue EMD using Ancillary
catalogue.
> Create ancillary service and issue EMD without the
Ancillary catalogue.
> Work with insurance services in a Passenger Name
Record (PNR).
> Reissue an e-ticket manually.
> Reissue an EMD.
> How to use an EMD partially and price a new e-ticket.
> How to refund an e-ticket manually.

Through a set of interactive lessons, learn how to
create, copy, and split a PNR and access associated
PNRs, create and issue EMDs with and without using
the ancillary catalogue, work with insurance services,
reissue EMDs and e-tickets, and manually refund
e-tickets.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 hours + 15 minutes English Fundamentals Yes No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Fare Filing Agents, Help Desk & Support
Agents, Reservation Agents, Ticketing Agents, Trainers

Things you need for this course
Pre-requisite: 
Altéa Reservation Desktop Web awareness learning path

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Altéa Reservation Desktop Web awareness [e-Learning]   

How the course is organised
First, there is the Altéa Reservation Desktop Web awareness
learning path, which is not mandatory. Then, there are ten
mandatory e-learning lessons. Finally, there is a user guide
available for download.

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> Google Chrome browser or alternatively the Microsoft Edge
browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

© 2026 Amadeus IT Group SA 15 amadeus.com

https://learning-universe.amadeus.com/c/portal/learning-path/open?plid=26948935&lpId=830
https://www.learn.amadeus.com/CourseSheetDisplay-2507077960.htm?version=3


Instructor-Led
Amadeus Altéa DC Aircraft Engineering and Business
Database
The Altéa Departure Control Aircraft Engineering and Business Database course describes the process of
constructing and maintaining carrier and aircraft weight & balance engineering data using the Database
Maintenance Tool (DBM).

On this course, you will learn about the:
> Development of appropriate aircraft engineering data.
> Process of entering such data into the database using
the DBM.
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database configurations.
> Data-building philosophy.
> Testing and pre-implementation acceptance
processes including any regulatory considerations.

This course covers the following topics:
> General engineering parameters
> Hold Data & ULD Configurations
> General limitations
> CG limits, Stabiliser trim
> Service weight adjustments and potable water
> Fuel tanks and distributions, Cabin layouts
> Aircraft business rules Flight creation process
> Integration of DBM data with other Altéa applications
> Autoload, General load control business data 

On this course, you will learn about the:
> Development of appropriate aircraft engineering data.
> Process of entering such data into the database using
the DBM.
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database configurations.
> Data-building philosophy.
> Testing and pre-implementation acceptance
processes including any regulatory considerations.

This course covers the following topics:
> General engineering parameters
> Hold Data & ULD Configurations
> General limitations
> CG limits, Stabiliser trim
> Service weight adjustments and potable water
> Fuel tanks and distributions, Cabin layouts
> Aircraft business rules Flight creation process
> Integration of DBM data with other Altéa applications
> Autoload, General load control business data 

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 75% 4 days English Advanced Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration.

> Airline staff responsible for the development of engineering
limitations data.

> Airline staff responsible for importing and maintenance of
carrier and aircraft data used for weight and balance functions
of Flight Management.

Things you need for this course
Pre-requisite: 
> Be involved in the maintenance of carrier and aircraft
engineering records.

> Have a good understanding of aircraft weight and balance
limitations and their utilisation within the ramp, load control
and flight operations environments.

> Be familiar with IATA AHM565 documentation.

> Have successfully passed one of these courses:

Altea Departure Control - Flight Management awareness

e-learning (3 hours)
Or the Altéa DC-FM Certification course

Prework: 
> Prepare your users & passwords in PDT Admin GUI (DBM)
of your airline. Ask your LSS Administrator.

> Access to the Admin GUI of your airline in PDT.

> You will need these accesses to join the training. Without
these accesses you may not be accepted in the training.

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led]   

How the course is organised
> 4 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: December 2025
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Instructor-Led
Amadeus Altéa DC Aircraft Engineering and Business
Database General Refresher
This one-day training is a refresher of the initial  Amadeus Altéa DC Aircraft Engineering and Business Data  DBM
training. The content is a pre-defined high-level training, limited to some of the more complex concepts of the initial
training that may be difficult to follow by referencing the user guide only.

On this course, you will learn about the:
> Development of appropriate aircraft engineering data
(review).
> Process of entering such data into the database using
the DBM (review).
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database
configurations (review).
> Data-building philosophy (review).
> Testing and preimplementation acceptance
processes including any regulatory
considerations (review).

This course covers the following topics:
> Overview of general data concepts
> Overview of cargo hold data and processing
> Overview of fuel data and processing
> Overview of Center of Gravity data and processing
> Overview of flight creation

On this course, you will learn about the:
> Development of appropriate aircraft engineering data
(review).
> Process of entering such data into the database using
the DBM (review).
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database
configurations (review).
> Data-building philosophy (review).
> Testing and preimplementation acceptance
processes including any regulatory
considerations (review).

This course covers the following topics:
> Overview of general data concepts
> Overview of cargo hold data and processing
> Overview of fuel data and processing
> Overview of Center of Gravity data and processing
> Overview of flight creation

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Advanced Yes No

Is this the course for you?
This course is for:
> Airlines hosted on Altéa Flight Management.

> Airline staff responsible for the development of engineering
limitations data.

> Airline staff responsible for importing and maintenance of
carrier and aircraft data used for weight and balance functions
of Flight Management.

Things you need for this course
Pre-requisite: 
> Have attended the initial Amadeus Altéa DC Aircraft

Engineering and Business Database course (4 days).

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC Aircraft Engineering and Business

Database [Instructor-Led] 

> Amadeus Altéa DC-FM Certification [Instructor-Led] 

> Amadeus Altéa DC Aircraft Engineering and Business

Database Modular Refresher [Instructor-Led]   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa DC Aircraft Engineering and Business
Database Modular Refresher
This one-day training is a refresher of the initial  Amadeus Altéa DC Aircraft Engineering and Business Data  DBM
course. The content is tailored to the needs of the customer by offering pre-defined modules for the customer to
select from. This course is appropriate for customers looking for more detailed refresher training on specific areas
of data configuration.

On this course, you will learn about the:
> Development of appropriate aircraft engineering data
(review).
> Process of entering such data into the database using
the DBM (review).
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database
configurations (review).
> Data-building philosophy (review).
> Testing and preimplementation acceptance
processes including any regulatory
considerations (review).

The customer builds its own agenda, selecting up to 4
of the following topics:
> General Data Concepts: Effective Dates, Data
Organization, Data Structure, DBM navigation
> Hold Data: basic DBM data configuration of BPPs and
ULD Groups, full width records and locks
> FM processing of Hold Data: FM processing of cargo
hold ULD group data during the approve distribution
process
> Fuel Data: basic fuel tank and distribution
configurations and FM processing
> Centre of Gravity Envelopes: basic DBM configuration
and FM processing
> Flight Create and Flight Create Business Rules, DPS
> Open Questions

On this course, you will learn about the:
> Development of appropriate aircraft engineering data
(review).
> Process of entering such data into the database using
the DBM (review).
> Engineering/mathematical functions within Flight
Management (FM) that are essential to the
development of aircraft database
configurations (review).
> Data-building philosophy (review).
> Testing and preimplementation acceptance
processes including any regulatory
considerations (review).

The customer builds its own agenda, selecting up to 4
of the following topics:
> General Data Concepts: Effective Dates, Data
Organization, Data Structure, DBM navigation
> Hold Data: basic DBM data configuration of BPPs and
ULD Groups, full width records and locks
> FM processing of Hold Data: FM processing of cargo
hold ULD group data during the approve distribution
process
> Fuel Data: basic fuel tank and distribution
configurations and FM processing
> Centre of Gravity Envelopes: basic DBM configuration
and FM processing
> Flight Create and Flight Create Business Rules, DPS
> Open Questions

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Advanced Yes No

Is this the course for you?
This course is for:
> Airlines hosted on Altéa Flight Management.

> Airline staff responsible for the development of engineering
limitations data.

> Airline staff responsible for importing and maintenance of
carrier and aircraft data used for weight and balance functions
of Flight Management.

Things you need for this course
Pre-requisite: 
> Have attended the initial Amadeus Altéa DC Aircraft

Engineering and Business Database course (4 days).

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC Aircraft Engineering and Business

Database [Instructor-Led] 

> Amadeus Altéa DC-FM Certification [Instructor-Led] 

> Amadeus Altéa DC Aircraft Engineering and Business

Database General Refresher [Instructor-Led]   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa DC-CM Advanced
This course builds upon the CM certification course by exploring complex scenarios for effective problem solving
with the use of hands-on exercises. involving customer handling activities in the operational window.

On this course, you will learn how to:
> Describe the relationship between Altéa DC-CM and
Altéa Administration.
> Interpret the business rules affecting customer
handling activities including acceptance, seating,
baggage, boarding and post departure process.
> Evaluate how the business rule relates to the
departure plan activities.

 

This course covers the topic of analysis of the
components and elements that influence specific
customer handling scenarios in the following areas:
> Customer acceptance
> Printing Documentation
> Baggage Handling
> Flight Information 
> Seating Management
> Post departure procedure

On this course, you will learn how to:
> Describe the relationship between Altéa DC-CM and
Altéa Administration.
> Interpret the business rules affecting customer
handling activities including acceptance, seating,
baggage, boarding and post departure process.
> Evaluate how the business rule relates to the
departure plan activities.

 

This course covers the topic of analysis of the
components and elements that influence specific
customer handling scenarios in the following areas:
> Customer acceptance
> Printing Documentation
> Baggage Handling
> Flight Information 
> Seating Management
> Post departure procedure

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Advanced Yes No

Is this the course for you?
This course is for:
> DCS system administrators

> DCS Trainers

> Help Desk & Support Agents

Things you need for this course
Pre-requisite: 
Have successfully passed ALL the courses below:

> Amadeus Altéa DC-CM Certification
> Amadeus Altéa DC-CM Business Rules
> Amadeus Altéa DC-CM Departure Plan Template &

Departure Control

Or have passed the Test: Amadeus Altéa DC-CM Advanced

Also be familiar with Altéa DC-CM and customer handling
activities at an airport.

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM)   

How the course is organised
> 2 days training

> Learner centered approach with outcome based scenario
exercises

This course is also available in
English

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa DC-CM Business Rules
This course describes business rules that determine the behaviour of Amadeus Altéa Departure Control - Customer
Management.

On this course you will learn how to:
> Create and maintain markets within Market
Management.
> Create and maintain Flight Groups within the Altéa
Administration.
> Identify the impact business rules have on the
behaviour of Customer Management.

This course covers the following topics:
> Market management
> Flight groups
> Weighting concept
> Advance passenger information service rules
> Customer acceptance rules
> Baggage acceptance rules
> Boarding pass and baggage tag printing rules
> Transfer rules
> Onload / Regrade rules
> Flight information rules

On this course you will learn how to:
> Create and maintain markets within Market
Management.
> Create and maintain Flight Groups within the Altéa
Administration.
> Identify the impact business rules have on the
behaviour of Customer Management.

This course covers the following topics:
> Market management
> Flight groups
> Weighting concept
> Advance passenger information service rules
> Customer acceptance rules
> Baggage acceptance rules
> Boarding pass and baggage tag printing rules
> Transfer rules
> Onload / Regrade rules
> Flight information rules

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline staff responsible for setting up the Customer
Management Business Rules

> Airline trainers

Things you need for this course
Pre-requisite: 
Have successfully passed:

> Altéa DC-CM Certification

Or 

> Be familiar with Amadeus Altéa Departure Control -
Customer Management and baggage handling activities at an
airport

Prework: 
To ensure that you are familiar with Amadeus products before
attending this course, we recommend to complete the
following e-learning:

> Altea Departure Control - Customer Management

awareness (9 hours)

> Altéa Administration Customer Management Business Rules

awareness (1 hours)

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM)   

How the course is organised
> 2 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa DC-CM Certification
This course explains how to use the check-in features of the Amadeus Altéa Departure Control - Customer
Management solution.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to :
> Navigate the Customer Management user interface.
> Access each application to process a customer for
acceptance and boarding.
> Manage disruption scenarios and their impact on
Customer Management.

This course covers the following topics:
> Working with flight information and departure plan
activities.
> Performing customer acceptance activities
> Handling baggage acceptance processes
> Managing seating allocation (including chargeable
seats)
> Monitoring the Regrade and Onload lists.
> Boarding customers
> Working with flight disruptions

On this course, you will learn how to :
> Navigate the Customer Management user interface.
> Access each application to process a customer for
acceptance and boarding.
> Manage disruption scenarios and their impact on
Customer Management.

This course covers the following topics:
> Working with flight information and departure plan
activities.
> Performing customer acceptance activities
> Handling baggage acceptance processes
> Managing seating allocation (including chargeable
seats)
> Monitoring the Regrade and Onload lists.
> Boarding customers
> Working with flight disruptions

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 5 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration.

> Airline administrators performing customer service
activities.

> Airline trainers.

Things you need for this course
Pre-requisite: 
> A basic knowledge of Passenger Name Records (PNR).

> Familiar with customer and baggage handling activities at an
airport

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (9 hours):

Altea Departure Control - Customer Management awareness

This course helps you use
> Altéa Departure Control - Customer Management (CM)   

Related courses
> Amadeus Altéa DC-CM Business Rules [Instructor-Led]   

How the course is organised
> 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: August 2025
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Instructor-Led
Amadeus Altéa DC-CM Departure Plan Template &
Departure Control
This course describes how to automate departure control activities at pre-determined times before and after
departure of an aircraft, such as issuing of post departure messages, using Amadeus Altéa Departure Control -
Customer Management.

During this course you will learn how to:
> Create, delete and modify a departure plan template.
> Set activities and dependencies.
> View and update the Departure Plan for a specific
flight in Customer Management.

This course covers the following topics:
> Identifying the market template levels
> Creating and modifying templates
> Adding and deleting activities
> Replacing and ignoring activities
> Deleting templates
> Adding dependencies

During this course you will learn how to:
> Create, delete and modify a departure plan template.
> Set activities and dependencies.
> View and update the Departure Plan for a specific
flight in Customer Management.

This course covers the following topics:
> Identifying the market template levels
> Creating and modifying templates
> Adding and deleting activities
> Replacing and ignoring activities
> Deleting templates
> Adding dependencies

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 1 day English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline administrators responsible for setting up Customer
Management activities

> Airline trainers

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Altéa DC-CM Certification

or

> Familiar with Amadeus Altéa Departure Control - Customer
Management and baggage handling activities at an airport.

Prework: 
To ensure that you are familiar with our products before
attending the training, we recommend that you complete the
following e-learning:

> Altéa Administration Departure Plan Template awareness
 (20 minutes)

> Altéa Departure Control - Customer Management

awareness (9 hours)

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM)   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: February 2026
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Instructor-Led
Amadeus Altéa DC-FM Business Rules & Departure
Plan Simulation
This course describes how business rules can modify Amadeus Altéa Departure Control - Flight Management's
behaviour and align it with your business goals. Generally, the business rules are applied either at flight creation or
at different stages of the flight life cycle including the operational window. These two phases are called Flight
Create business rules and Active Flight business rules respectively.

In this course you will learn how to:
> Create and maintain markets within Market
Management.
> Create and maintain flight group keywords within
Flight Group Management.
> Work with the weighting concept.
> Create and verify mandatory business rules.
> Identify the impact that business rules have on the
behaviour of Flight Management.

This course covers the following topics:
> Market Management.
> Flight Group Management.
> Rule Criteria Weights.
> Rule Creation.
> Rule Management.
> Flight Create Business Rules.
> Active Flight Business Rules.
> Departure Plan Simulation.

In this course you will learn how to:
> Create and maintain markets within Market
Management.
> Create and maintain flight group keywords within
Flight Group Management.
> Work with the weighting concept.
> Create and verify mandatory business rules.
> Identify the impact that business rules have on the
behaviour of Flight Management.

This course covers the following topics:
> Market Management.
> Flight Group Management.
> Rule Criteria Weights.
> Rule Creation.
> Rule Management.
> Flight Create Business Rules.
> Active Flight Business Rules.
> Departure Plan Simulation.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration.

> Airline staff and airline trainers responsible for setting up
the Altéa Departure Control - Flight Management Business
Rules.

> Airline system administrators.

Things you need for this course
Pre-requisite: 
Have successfully passed:

> Amadeus Altéa DC-FM Certification

Or

> Be familiar with Amadeus Altéa Flight Management as well
as weight and balance activities at an airport.

Prework: 
To ensure that you are familiar with Amadeus products before
attending the training, we recommend you complete the
following e-Learning:

> Altéa Administration Flight Management Business Rules

awareness (1 hour)

> Altéa Departure Control - Flight Management awareness
 (2.5 hours)

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led]   

How the course is organised
> 2 days training.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa DC-FM Certification
This course explains how to use the modules associated with load control in Amadeus Altéa Departure Control -
Flight Management.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn to:
> Prepare flights for departure through the load control
process.
> Produce documentation relating to the load
control process.
> Identify Altéa DC-FM functionality for other system
users.
> Understand Altéa DC-FM from the perspective of
roles such as freight agent, ramp agent and supervisor.
> Perform the role of load controller, ramp agent or
freight agent through demonstrations and exercises.

This course covers the following topics:
> Altéa system architecture
> Flight information
> Deadload
> Load distribution
> Passenger data
> Down-line port restrictions
> Offline - Online flight scenario
> Domain allocation
> Load control supervisor
> Disruption management
> Ramp sub applicatiion
> Freight sub application
> Documentation

On this course, you will learn to:
> Prepare flights for departure through the load control
process.
> Produce documentation relating to the load
control process.
> Identify Altéa DC-FM functionality for other system
users.
> Understand Altéa DC-FM from the perspective of
roles such as freight agent, ramp agent and supervisor.
> Perform the role of load controller, ramp agent or
freight agent through demonstrations and exercises.

This course covers the following topics:
> Altéa system architecture
> Flight information
> Deadload
> Load distribution
> Passenger data
> Down-line port restrictions
> Offline - Online flight scenario
> Domain allocation
> Load control supervisor
> Disruption management
> Ramp sub applicatiion
> Freight sub application
> Documentation

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 5 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline staff responsible for designing and delivering end
user training and implementation of Amadeus Altéa DC - Flight
Management.

Things you need for this course
Pre-requisite: 
Be familiar with:

> Flight Management Departure Plan activities.

> Load control activities.

> Airline business procedures.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (3 hours):

Altea Departure Control - Flight Management awareness

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

How the course is organised
> 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: May 2025
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Instructor-Led
Amadeus Altéa DC-FM Departure Plan Template &
Departure Control
This course describes how to automate departure control activities at pre-determined times before and after
departure of an aircraft, such as issuing of a loadsheet, using Amadeus Altéa Departure Control - Flight
Management.

 In this course you will learn how to:
> Create, delete and modify a departure plan template.
> Set activities and dependencies.
> View and update the Departure Plan (or Event
Scheduler) for a specific flight in Flight Management.

 

This course covers the following topics:
> Identifying the market template levels
> Creating and modifying templates
> Adding and deleting activities
> Replacing and ignoring activities
> Deleting templates
> Adding dependencies

 In this course you will learn how to:
> Create, delete and modify a departure plan template.
> Set activities and dependencies.
> View and update the Departure Plan (or Event
Scheduler) for a specific flight in Flight Management.

 

This course covers the following topics:
> Identifying the market template levels
> Creating and modifying templates
> Adding and deleting activities
> Replacing and ignoring activities
> Deleting templates
> Adding dependencies

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 1 day English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline administrators responsible for setting up Flight
Management departure plan activities

> Airline trainers

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Altéa DC-FM Certification

or

> Be familiar with Amadeus Altéa Flight Management and
weight and balance activities at an airport.

Prework: 
To ensure that you are familiar with Amadeus products before
attending the training, we recommend that you complete the
following e-learning:

> Altéa Administration Departure Plan Template awareness
 (20 minutes)

> Altéa Departure Control - Flight Management awareness 
 (2.5 hours)

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led]   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: February 2026
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Instructor-Led
Amadeus Altéa DC-FM Wide Body Freighter
Functionality (Cargo)
This course describes in detail the load control process to manage wide body freighters in Amadeus Altéa
Departure Control - Flight Management.

On this course, you will learn how to:
> Navigate and use Altéa DC-FM.
> Build ULDs using the wide body Main Deck Loading
functionality.
> Manually distribute the load on the Main and Lower
Decks.
> Accept passengers (e.g. grooms, couriers, and 
attendants).
> Produce relevant documentation, Loadsheet, LIR,
VGLIR, LDM, CPM and UCM.

This course covers the following topics:
> Freighter functionality focusing on Deadload,
Deadload details and Load distribution screens
> Passenger acceptance
> ULD creation - Pallet
> DGSL
> Temperature and ventilation
> Documentation
> Messages
> Ground stability

On this course, you will learn how to:
> Navigate and use Altéa DC-FM.
> Build ULDs using the wide body Main Deck Loading
functionality.
> Manually distribute the load on the Main and Lower
Decks.
> Accept passengers (e.g. grooms, couriers, and 
attendants).
> Produce relevant documentation, Loadsheet, LIR,
VGLIR, LDM, CPM and UCM.

This course covers the following topics:
> Freighter functionality focusing on Deadload,
Deadload details and Load distribution screens
> Passenger acceptance
> ULD creation - Pallet
> DGSL
> Temperature and ventilation
> Documentation
> Messages
> Ground stability

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2 days English Advanced Yes Yes

Is this the course for you?
This course is for:
> Airline staff responsible for designing and delivering end
user training and implementation of freighter functionalities in
Amadeus Altéa Departure Control - Flight Management.

Things you need for this course
Pre-requisite: 
You need to be familiar with:

> The Altéa DC-FM solution. 

> Flight Management Departure Plan activities.

> Load control activities.

> Airline business procedures.

Prework: 
> To ensure that you are familiar with our solutions before
attending the training, complete the following e-learning (3
hours):

Altea Departure Control - Flight Management awareness

This course helps you use
> Altéa Departure Control - Flight Management (FM)   

How the course is organised
> 2 days training for airline agents who have passed the Altéa
DC-FM certification

> or 5 days training including an Altéa DC-FM certification

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:

> learning@amadeus.com

> Last update: June 2024
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Instructor-Led
Amadeus Altéa DCS Help Desk for Airlines
This course gives a global picture of the Altéa DCS process flows, covering flight creation to post departure. It also
explains how airlines help desk agents should support Altéa Customer Management and Flight Management users
in solving their daily issues.

In this course you will learn how to:
> Investigate most of the common incidents.
> Understand the flow of the flight cycle.
> Search for information in order to solve or reject an
incident.
> Navigate the different Altéa solutions to identify
missing information or wrong settings.
> Follow the procedures to report incidents.

 This course cover the following topics: 
> Incident handling and reporting
> Altéa solution system architecture
> JFE access issues
> Failure to create a flight
> Seating management
> Baggage management
> Device and printing management
> Flight history in Altéa DC-FM
> CM/FM 'link is down' scenarios
> First steps of a problem investigation

In this course you will learn how to:
> Investigate most of the common incidents.
> Understand the flow of the flight cycle.
> Search for information in order to solve or reject an
incident.
> Navigate the different Altéa solutions to identify
missing information or wrong settings.
> Follow the procedures to report incidents.

 This course cover the following topics: 
> Incident handling and reporting
> Altéa solution system architecture
> JFE access issues
> Failure to create a flight
> Seating management
> Baggage management
> Device and printing management
> Flight history in Altéa DC-FM
> CM/FM 'link is down' scenarios
> First steps of a problem investigation

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline Help Desk agents

Things you need for this course
Pre-requisite: 
> Complete the Amadeus Incident Management for support

agents e-Learning (1 hour).

> Successfully pass the full CM or FM certifications below:
   Amadeus Altéa DC-CM certification.
+ Amadeus Altéa DC-CM Business Rules.
+ Amadeus Altéa DC-CM Departure Plan Template &

Departure Control.
Or 
   Amadeus Altéa DC-FM certification.
+ Amadeus Altéa DC-FM Business Rules & Departure Plan

Simulation.
+ Amadeus Altéa DC-FM Departure Plan Template &

Departure Control.

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM)   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led]   

How the course is organised
> 1 hour of e-Learning.

> 3 days training.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Altéa Document Management for Altéa
Departure Control
This course explains how to set up device and print management for Altéa carriers using DCS.

 On this course you will learn how to:
> Set up devices for ground handling and printing at the
airport.
> Set up predefined print formats and associate them.   

 

 This course covers the following topics:
> Concepts used in Device Administration.
> Completing the 5-step fixed-registration process.
> Determining the printing flows to retrieve various print
devices.
> Setting up shared printers (host sharing).
> Completing the 4-step auto-registration process.
> Creating a location description and zones to utilise
them in Customer Management.
> Identifying and adding available format associations.
> Viewing print queues within the queue application.
> Security and access for Document Manager.   

 On this course you will learn how to:
> Set up devices for ground handling and printing at the
airport.
> Set up predefined print formats and associate them.   

 

 This course covers the following topics:
> Concepts used in Device Administration.
> Completing the 5-step fixed-registration process.
> Determining the printing flows to retrieve various print
devices.
> Setting up shared printers (host sharing).
> Completing the 4-step auto-registration process.
> Creating a location description and zones to utilise
them in Customer Management.
> Identifying and adding available format associations.
> Viewing print queues within the queue application.
> Security and access for Document Manager.   

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

Things you need for this course
Pre-requisite: 
> Airline/Airport experience with regards to printers/CUTE
environment.

This course helps you use
> Altéa Document Management   

How the course is organised
> 2 virtual training sessions of 3 hours.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: April 2022
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Instructor-Led
Amadeus Altéa Inventory - Inventory Management
Advanced
This course builds upon the Inventory certification course by exploring complex scenarios for effective problem
solving with the use of hands-on exercises. You will improve your ability to manage the application, get informed
about recent changes or developments, and address Inventory control scenarios.

In this course, you will be able to: 
> Master the flight date inventory Leg and Segment
controls and measure their impact on Reservation.
> Explore the Flight date inventory tabs.
> Reassess how Availability is calculated and published.
> Display different availability depending on the Point
of Sale. Introduction to Availability - polling. 
> Manage inventory business rules and TIA.
> Detect, and deal with overbookings.
> Examine Inventory History and Queue Monitoring.
> Describe Revenue Availability w/Active Valuation.
> Evaluate the Uncommitted Bookings tool.
> Use available resources such as online help, manuals,
and other documentation to find information and
resolve issues. Encourage continuous learning and
self-service support.
> Handle challenging situations.

This course covers the following topics:
> Inventory server responsibilities and interactions
> Flight date inventory screen: Leg and Segment
controls, Flight controls, Different types of
Nesting, Mass updates and supplementary information
> Availability computation
> Availability limitation controls: Segment
Limit, Gating, POS subclass logic
> Inventory business rules and TIA
> Market data reports
> Uncommitted Bookings tool
> Problem solving

In this course, you will be able to: 
> Master the flight date inventory Leg and Segment
controls and measure their impact on Reservation.
> Explore the Flight date inventory tabs.
> Reassess how Availability is calculated and published.
> Display different availability depending on the Point
of Sale. Introduction to Availability - polling. 
> Manage inventory business rules and TIA.
> Detect, and deal with overbookings.
> Examine Inventory History and Queue Monitoring.
> Describe Revenue Availability w/Active Valuation.
> Evaluate the Uncommitted Bookings tool.
> Use available resources such as online help, manuals,
and other documentation to find information and
resolve issues. Encourage continuous learning and
self-service support.
> Handle challenging situations.

This course covers the following topics:
> Inventory server responsibilities and interactions
> Flight date inventory screen: Leg and Segment
controls, Flight controls, Different types of
Nesting, Mass updates and supplementary information
> Availability computation
> Availability limitation controls: Segment
Limit, Gating, POS subclass logic
> Inventory business rules and TIA
> Market data reports
> Uncommitted Bookings tool
> Problem solving

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Advanced Yes No

Is this the course for you?
This course is for:
Airline revenue managers, inventory controllers and
supervisors who have some product experience and want to
expand their product knowledge towards an advanced level.

This standard course does not suit to users who already
master the above topics and does not cover any customized
troubleshooting or configuration checks that are unique to
your airline. 

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification
Inventory Management Certification.
Or

> Have passed the Test: Amadeus Altéa Inventory - Inventory

Management Advanced.

This course helps you use
> Altéa Inventory and Code Share   

How the course is organised
> 3 days training

> Learner centered approach with outcome based scenario
exercises

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Altéa Inventory - Inventory Management
Certification
This course explains how to use the Amadeus Altéa Inventory solution for airline inventory management. You will
practice using hands-on exercises leading to a certification test.

On this course, you will learn how to:
> Work on the Flight Date Inventory Leg and Segment.
> Apply various class controls to manage inventory
effectively.
> Utilize the settings on the Supplementary and Mass
updates tabs.
> Close the Flight.
> Handle Balance and Unbalance adjustments.
> Update the saleable configuration from Flight Date
Inventory.
> Create a Non-Commercial PNR.
> Explain how availability is calculated.
> Describe the Emergency Lock procedure.

This course covers the following topics:
> Altéa system architecture
> Navigation of the product's UI and menus
> Messenger viewer
> Markets, flight groups and business rules
> Flight Date Inventory Controls
> Supplementary tabs
> Mass updates
> Availability calculation and publication
> Nesting
> Mandatory Inventory business rules

On this course, you will learn how to:
> Work on the Flight Date Inventory Leg and Segment.
> Apply various class controls to manage inventory
effectively.
> Utilize the settings on the Supplementary and Mass
updates tabs.
> Close the Flight.
> Handle Balance and Unbalance adjustments.
> Update the saleable configuration from Flight Date
Inventory.
> Create a Non-Commercial PNR.
> Explain how availability is calculated.
> Describe the Emergency Lock procedure.

This course covers the following topics:
> Altéa system architecture
> Navigation of the product's UI and menus
> Messenger viewer
> Markets, flight groups and business rules
> Flight Date Inventory Controls
> Supplementary tabs
> Mass updates
> Availability calculation and publication
> Nesting
> Mandatory Inventory business rules

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification No Yes

Is this the course for you?
This course is for:
> Airline Inventory Controllers or Revenue Managers and
supervisors who are new to Inventory Management.

> Non Inventory daily users should watch:

Altea Inventory awareness e-Learning (6 hours)

> Schedule Managers:
4-day 'Schedule Management Certification'.

> Seating Managers:
3-day 'Seating Management Certification'.

> For a full Inventory certification covering all inventory areas:
7-day 'Altéa Inventory Certification'.

> Users with a significant experience should enrol to one of
our advanced courses.

Things you need for this course
Prework: 
> To ensure that you are familiar with the cryptic commands
before attending the training, we recommend you complete
the following e-learning (45 minutes):

Altéa Reservation and Ticketing (Cryptic) for Altéa Inventory

users

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory - Inventory Management

Advanced [Instructor-Led] 

> Amadeus Altéa Inventory Codeshare Certification

[Instructor-Led]   

How the course is organised
> 3 days of training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: March 2026
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Instructor-Led
Amadeus Altéa Inventory - Schedules &
Reaccommodation Advanced
This course builds upon the Inventory and Schedules certification course by exploring complex scenarios for
effective problem solving with the use of hands-on exercises. You will improve your ability to manage the
application, get informed about recent changes or developments, and address schedules and reaccommodation
scenarios.

In this course, you will be able to: 
> Master manual/automatic schedule processes of
message reception, dressing and publication, measure
their impact internally/externally.
> Work with the SET (Schedule Entry Table).
> Manage regular and non-regular flights.
> Define optional schedule business rules and TIA.
> Examine the schedule history and Queue Monitoring.
> Monitor operational messages and manage FLIX. 
> Master the automatic and manual reaccommodation
process: Types/Modes/Solutions/Options
> Maximize the automatic flight selection (AFS) feature.
> Manage optional reaccommodation business rules.
> Optimize features like overbooking control, itinerary
analysis and enhanced reaccommodation .
> Employ the reaccommodation from report tool.
> Examine reaccommodation history and interpret
queue monitoring and the reaccommodation reports.
> Handle challenging situations.

This course covers the following topics:
> Reception and decoding of schedule messages
> Schedule dressing, business rules, Aircraft
configuration version
> Schedule entry table (SET)
> Schedule maintenance & publication
> Internal & external publication
> Automatic and manual publication + customization
> FLIX and operational messages
> Reaccommodation: Modes/Types/Solutions/Options
> Automatic flight selection
> Reaccommodation business rules
> Manual and automatic reaccommodation
> Reports, history and queue monitoring
> Itinerary analysis & Overbooking control
> Enhanced reaccommodation
> Reaccommodation from report (RFR)
> Problem solving

In this course, you will be able to: 
> Master manual/automatic schedule processes of
message reception, dressing and publication, measure
their impact internally/externally.
> Work with the SET (Schedule Entry Table).
> Manage regular and non-regular flights.
> Define optional schedule business rules and TIA.
> Examine the schedule history and Queue Monitoring.
> Monitor operational messages and manage FLIX. 
> Master the automatic and manual reaccommodation
process: Types/Modes/Solutions/Options
> Maximize the automatic flight selection (AFS) feature.
> Manage optional reaccommodation business rules.
> Optimize features like overbooking control, itinerary
analysis and enhanced reaccommodation .
> Employ the reaccommodation from report tool.
> Examine reaccommodation history and interpret
queue monitoring and the reaccommodation reports.
> Handle challenging situations.

This course covers the following topics:
> Reception and decoding of schedule messages
> Schedule dressing, business rules, Aircraft
configuration version
> Schedule entry table (SET)
> Schedule maintenance & publication
> Internal & external publication
> Automatic and manual publication + customization
> FLIX and operational messages
> Reaccommodation: Modes/Types/Solutions/Options
> Automatic flight selection
> Reaccommodation business rules
> Manual and automatic reaccommodation
> Reports, history and queue monitoring
> Itinerary analysis & Overbooking control
> Enhanced reaccommodation
> Reaccommodation from report (RFR)
> Problem solving

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 4 days English Advanced Yes No

Is this the course for you?
This course is for:
Airline schedule managers, space controllers and supervisors
who have some product experience and want to expand their
product knowledge towards an advanced level.
This standard course does not suit to users who already
master the above topics and does not cover any customized
troubleshooting or configuration checks that are unique to
your airline. 

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification
Schedules & Reaccommodation Certification.
Or

> Have passed the Test: Amadeus Altéa Inventory -

Schedules & Reaccommodation Advanced

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Codeshare Certification

[Instructor-Led]   

How the course is organised
> 4 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Altéa Inventory - Schedules &
Reaccommodation Certification
This course explains how to use the Amadeus Altéa Inventory solution for schedule management and
re-accommodation. You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to:
> Manage automated and guided features used for the
creation, modification, and publication of regular flights.
> Set up automated and guided reaccommodation
processes effectively.

This course covers the following topics:
> Altéa system architecture
> Navigation of the product's UI and menus
> Messenger viewer
> Markets, flight groups and business rules
> Mandatory Schedule business rules
> Flight creation, modification, and publication
> Reaccommodation processing: automatic and
manual, using baseline features, and Automatic Flight
Selection

On this course, you will learn how to:
> Manage automated and guided features used for the
creation, modification, and publication of regular flights.
> Set up automated and guided reaccommodation
processes effectively.

This course covers the following topics:
> Altéa system architecture
> Navigation of the product's UI and menus
> Messenger viewer
> Markets, flight groups and business rules
> Mandatory Schedule business rules
> Flight creation, modification, and publication
> Reaccommodation processing: automatic and
manual, using baseline features, and Automatic Flight
Selection

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 4 days English Certification No Yes

Is this the course for you?
This course is for:
> Airline's Schedule Managers, Space controllers and
supervisors who are new to schedule distribution.

> Non Inventory daily users should watch:

Altea Inventory awareness e-Learning (6 hours)

> Seating Managers:

> 3-day 'Seating Management Certification'.

> Inventory Managers:
3-day 'Inventory Management Certification'.

> For a full Inventory certification covering all inventory areas:
7-day 'Altéa Inventory Certification'.

> Users with a significant experience should enrol to one of
our advanced courses.

Things you need for this course
Prework: 
> To ensure that you are familiar with the cryptic commands
before attending the training, we recommend you complete
the following e-learning (45 minutes):

Altéa Reservation and Ticketing (Cryptic) for Altéa Inventory

users

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Process Customer Value for Inventory

[Instructor-Led] 

> Amadeus Altéa Inventory - Schedules & Reaccommodation

Advanced [Instructor-Led] 

> Amadeus Altéa Inventory Codeshare Certification

[Instructor-Led]   

How the course is organised
> 4 days of training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: March 2026
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Instructor-Led
Amadeus Altéa Inventory - Seating Management
Advanced
This course builds upon the Inventory and Seating certification course by exploring complex seating scenarios for
effective problem solving with the use of hands-on exercises. You will improve your ability to manage the
application, get informed about recent changes or developments, and address complex seating scenarios.

In this course, you will be able to:
> Utilize the Aircraft Library efficiently and the seat map
designer 
> Manage mandatory and optional seat map templates
effectively
> Interpret the Flight Date Seat Map and master its
functions
> Apply and maintain Seating business rules
proficiently.
> Implement chargeable seating. 
> Examine how a seat is allocated and how passengers
are reseated.
> Use available resources such as online help, manuals,
and other documentation to find information and
resolve issues. Encourage continuous learning and
self-service support.
> Address challenging situations.

This course covers the following topics:
> Extended aircraft configuration code, schedule
changes
> Seat Map Designer: Mandatory and optional
templates
> Flight Date Seat Map
> Seating business rules
> Find Best Seat algorithm
> Reseating
> Chargeable Seating

In this course, you will be able to:
> Utilize the Aircraft Library efficiently and the seat map
designer 
> Manage mandatory and optional seat map templates
effectively
> Interpret the Flight Date Seat Map and master its
functions
> Apply and maintain Seating business rules
proficiently.
> Implement chargeable seating. 
> Examine how a seat is allocated and how passengers
are reseated.
> Use available resources such as online help, manuals,
and other documentation to find information and
resolve issues. Encourage continuous learning and
self-service support.
> Address challenging situations.

This course covers the following topics:
> Extended aircraft configuration code, schedule
changes
> Seat Map Designer: Mandatory and optional
templates
> Flight Date Seat Map
> Seating business rules
> Find Best Seat algorithm
> Reseating
> Chargeable Seating

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Advanced Yes No

Is this the course for you?
This course is for:
Airline seating agents, space controllers, schedule managers,
and supervisors who have some product experience and want
to expand their product knowledge towards an advanced level.

This standard course does not suit to users who already
master the above topics and does not cover any customized
troubleshooting or configuration checks that are unique to
your airline. 

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification
Seating Management Certification.
Or

> Have passed the Test: Amadeus Altéa Inventory - Seating

Management Advanced.

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Codeshare Certification

[Instructor-Led]   

How the course is organised
> 3 days training

> Learner centered approach with outcome based exercises

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Altéa Inventory - Seating Management
Certification
This course explains how to use the Amadeus Altéa Inventory solution for seating.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to:
> Create and maintain Aircraft Configuration Versions
(ACV). 
> Create and maintain seat maps used across Altéa
Reservation and Altéa Departure Control.
> Understand the construction of a flight date seat
map.
> Establish the essential seating business rules to
determine how passengers should be seated.

This course covers the following topics:
> Altéa system architecture.
> Navigation of the product's UI and menus.
> Messenger viewer.
> Markets, flight groups and business rules.
> Aircraft library.
> Seat map designer.
> Flight Date seatmap.
> Required seating business rules.

On this course, you will learn how to:
> Create and maintain Aircraft Configuration Versions
(ACV). 
> Create and maintain seat maps used across Altéa
Reservation and Altéa Departure Control.
> Understand the construction of a flight date seat
map.
> Establish the essential seating business rules to
determine how passengers should be seated.

This course covers the following topics:
> Altéa system architecture.
> Navigation of the product's UI and menus.
> Messenger viewer.
> Markets, flight groups and business rules.
> Aircraft library.
> Seat map designer.
> Flight Date seatmap.
> Required seating business rules.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes 3 days English Certification No Yes

Is this the course for you?
This course is for:
> Airline's Seating Managers, Space controllers, Helpdesk and
supervisors.

> Non Inventory daily users should watch:

Altea Inventory awareness e-Learning (6 hours)

> Schedule Managers:
4-day 'Schedule Management Certification'.

> Inventory Managers:
3-day 'Inventory Management Certification'.

> For a full Inventory certification covering all inventory areas:
7-day 'Altéa Inventory Certification'.

> Users with a significant experience should enrol to one of
our advanced courses.

Things you need for this course
Prework: 
To ensure that you are familiar with the cryptic commands
before attending the training, we recommend you complete
the following e-learning (45 minutes):

> Altéa Reservation and Ticketing (Cryptic) for Altéa Inventory

users

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Certification [Instructor-Led] 

> Amadeus Altéa Inventory - Seating Management Advanced

[Instructor-Led]   

How the course is organised
> 3 days of training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: March 2026
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Instructor-Led
Amadeus Altéa Inventory Certification
This course explains how to use the Amadeus Altéa Inventory solution for schedule, seating, re-accommodation
and inventory management.
You will practice using hands-on exercises leading to a comprehensive certification test.

On this course you will learn how to:
> Manage automated and guided features for the
creation, update and publication of regular flights.
> Setup automated and guided reaccommodation
processes effectively.
> Create and maintain seat maps displayed on Altéa
Reservation and Departure Control systems.
> Apply inventory management techniques to control
airline inventory and determine availability.

This course covers the following topics:
> Amadeus System architecture
> Navigation within the GUI, discovery of the menus
> Messenger viewer
> Markets, flight groups and business rules
> Seating: Aircraft library, seat map design, mandatory
business rules
> Schedule: Automatic / manual schedule changes and
publication, mandatory business rules
> Reaccommodation: Automatic and manual
reaccommodation using baseline features and
automatic flight selection
> Inventory: Flight date inventory, class/cabin controls,
availability calculation, supplementary settings and
business rules

On this course you will learn how to:
> Manage automated and guided features for the
creation, update and publication of regular flights.
> Setup automated and guided reaccommodation
processes effectively.
> Create and maintain seat maps displayed on Altéa
Reservation and Departure Control systems.
> Apply inventory management techniques to control
airline inventory and determine availability.

This course covers the following topics:
> Amadeus System architecture
> Navigation within the GUI, discovery of the menus
> Messenger viewer
> Markets, flight groups and business rules
> Seating: Aircraft library, seat map design, mandatory
business rules
> Schedule: Automatic / manual schedule changes and
publication, mandatory business rules
> Reaccommodation: Automatic and manual
reaccommodation using baseline features and
automatic flight selection
> Inventory: Flight date inventory, class/cabin controls,
availability calculation, supplementary settings and
business rules

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 7 days English Certification No Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline's operational agents, supervisors, Help desk agents
and trainers.

> For Schedule Managers: 'Schedule Management

Certification'.

> For Seating Managers: 'Seating Management Certification'.

> For Inventory Managers: 'Inventory Management

Certification'.

> For an overview of the Inventory systems, watch the

Altea Inventory awareness e-Learning (6h)

Things you need for this course
Prework: 
> To ensure that you are familiar with the cryptic commands
before attending the training, we recommend you complete
the following e-learning (45 minutes):

Altéa Reservation and Ticketing (Cryptic) for Altéa Inventory

users

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Codeshare Certification

[Instructor-Led]   

How the course is organised
> 7 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> If you already have a comprehensive knowledge of Altéa
Inventory, consider enrolling to one of our higher knowledge
level courses.

> Last update: August 2025
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Instructor-Led
Amadeus Altéa Inventory Codeshare Advanced
This course builds upon the Codeshare certification course by exploring complex scenarios for effective problem
solving with the use of hands-on exercises. It will also improve your proficiency in application management, update
you on recent modifications or advancements and address codeshare scenarios on schedules and
reaccommodation

In this course you will improve your skills to:
> Analyze and explain possible flight period locks.
> Manage and unlock flight periods caused by dressing
errors.
> Explain reaccommodation rules for finding alternative
flights.
> Address changes in flight numbers and booking
classes.
> Terminate a codeshare partnership.

This course covers the following topics:
> Schedule reception, dressing and publication in a
Free Flow agreement
> Codeshare Release Date
> Auto Codeshare Update
> Flight locks, SAC rule and SET (manual and error
status)
> Codeshare Dressing Error - Block Space Agreement
> Marketing Data Synchronization business rule
> Reaccommodation Mode/Type/Options
> Operating/Marketing flight nb or bkg class changes
> Codeshare refresh and reaccommodation
> Explanation of the reaccommodation settings in the
Amadeus Codeshare Portal
> Reaccommodation Business Rules
> Reports, history and queue monitoring
> Itinerary analysis, Overbooking control
> Franchise agreements
> Reaccommodation from report (RFR)
> Problem solving

In this course you will improve your skills to:
> Analyze and explain possible flight period locks.
> Manage and unlock flight periods caused by dressing
errors.
> Explain reaccommodation rules for finding alternative
flights.
> Address changes in flight numbers and booking
classes.
> Terminate a codeshare partnership.

This course covers the following topics:
> Schedule reception, dressing and publication in a
Free Flow agreement
> Codeshare Release Date
> Auto Codeshare Update
> Flight locks, SAC rule and SET (manual and error
status)
> Codeshare Dressing Error - Block Space Agreement
> Marketing Data Synchronization business rule
> Reaccommodation Mode/Type/Options
> Operating/Marketing flight nb or bkg class changes
> Codeshare refresh and reaccommodation
> Explanation of the reaccommodation settings in the
Amadeus Codeshare Portal
> Reaccommodation Business Rules
> Reports, history and queue monitoring
> Itinerary analysis, Overbooking control
> Franchise agreements
> Reaccommodation from report (RFR)
> Problem solving

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 4 days English Advanced Yes Yes

Is this the course for you?
This course is for:
Airline schedule managers, space controllers and supervisors
who have some product experience and want to expand their
product knowledge towards an advanced level.
This standard course does not target product users who have
already mastered the above topics and does not cover any
customized troubleshooting or configuration checks that are
unique to an airline. 

Things you need for this course
Pre-requisite: 
> Have successfully passed the Codeshare Certification
> Or have passed the Test: Amadeus Altéa Inventory

Codeshare Advanced

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the 2
following e-learning (25 minutes):

How to manage codeshare flights
Prerequisites to start using codeshare in Altéa Inventory?

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Certification [Instructor-Led]   

How the course is organised
> 4 days training (from 2026)

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: November 2025
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Instructor-Led
Amadeus Altéa Inventory Codeshare Certification
This course explains how to use the Amadeus Altéa Codeshare solution.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to create and update
codeshare tables and codeshare flights.

These tables are used by Amadeus Altéa Inventory
when a schedule or schedule change message is sent
from your schedule planning system or partner airlines
to automatically create or update your codeshare
flights.

This course covers the following topics:
> Codeshare agreement types
> Codeshare terminology
> Message flow
> Booking class mapping table
> Codeshare flight table
> Codeshare disclosure in Altéa Reservation
> Functionality agreement
> Codeshare seat map and seat management of code
share flights
> Inventory management of code share flights
> Amadeus Codeshare portal
> Codeshare re-accommodation

On this course, you will learn how to create and update
codeshare tables and codeshare flights.

These tables are used by Amadeus Altéa Inventory
when a schedule or schedule change message is sent
from your schedule planning system or partner airlines
to automatically create or update your codeshare
flights.

This course covers the following topics:
> Codeshare agreement types
> Codeshare terminology
> Message flow
> Booking class mapping table
> Codeshare flight table
> Codeshare disclosure in Altéa Reservation
> Functionality agreement
> Codeshare seat map and seat management of code
share flights
> Inventory management of code share flights
> Amadeus Codeshare portal
> Codeshare re-accommodation

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline staff who will be responsible for setting up and
maintaining codeshare relationships.

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification
Schedules & Reaccommodation Certification.

> Or have passed the Test: Amadeus Altéa Inventory

Codeshare Certification

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the 2
following e-learning (25 minutes):

How to manage codeshare flights
What are the prerequisites to start using codeshare in Altéa

Inventory?

This course helps you use
> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory Certification [Instructor-Led]   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: March 2026
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Instructor-Led
Amadeus Altéa Inventory for Altéa DC-CM
Standalone
This course provides an overview of Altéa Inventory's system architecture and integration with Altéa Departure
Control - Customer Management, focusing on seat management and scheduling. Through practical exercises learn
how to create and maintain aircraft configurations, seat maps, and seating business rules, that impact the
departure control system during the flight operational window.

On this course, you will learn to:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Set up flight schedules and activate flights in
Customer Management.
> Recognize how schedule changes affect passenger
reseating.
> Investigate and resolve issues, such as locked flights.

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Seat rules and their impact on seat maps
> Flight schedules and when they are triggered to
Customer Management
> Schedule changes and passenger reseating
> Business rules for DCS triggers and Res-DCS
exchange

On this course, you will learn to:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Set up flight schedules and activate flights in
Customer Management.
> Recognize how schedule changes affect passenger
reseating.
> Investigate and resolve issues, such as locked flights.

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Seat rules and their impact on seat maps
> Flight schedules and when they are triggered to
Customer Management
> Schedule changes and passenger reseating
> Business rules for DCS triggers and Res-DCS
exchange

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Awareness Yes No

Is this the course for you?
This course is for:
Altéa DC-CM Standalone airlines.

Things you need for this course
Pre-requisite: 
> Amadeus Altéa DC-CM Departure Plan Template &
Departure Control

> Amadeus Altéa DC-CM Business Rules

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa DC-CM Certification [Instructor-Led]   

How the course is organised
> 2 days instructor-led with practical exercises 

 

This course is also available in
English

What equipment do you need?
> View our instructor-led requirements

The last few details...
> To schedule a customised session, please contact
learning@amadeus.com

> Last update February 2026.
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Instructor-Led
Amadeus Altéa Inventory for Altéa DC-CM/FM
standalone
This course delivers a comprehensive overview of Altéa Inventory's system architecture and its integration with
Altéa Departure Control, emphasizing seat management, aircraft configuration, and flight scheduling. Participants
will take part in practical exercises to create and maintain aircraft setups, design seat maps, define seating
business rules, manage flight schedules including locked flights and oversee the Schedule Entry Table (SET)
process, all of which impact departure control operations during the flight window.

In this course, you will learn:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Recognize how schedule changes affect passenger
reseating.
> Set up flight schedules and activate flights in the DCS
operational window.
> Manage the Schedule Entry Table (SET).
> Investigate and resolve issues, such as locked flights.

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Seat rules and their impact on seat maps
> Flight schedules and when they are triggered to Flight
Management
> Schedule Entry Table (SET)
> Schedule changes and passenger reseating
> Schedule business rules, both mandatory and
optional
> Business rules for DCS triggers and Res-DCS
exchange

 

In this course, you will learn:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Recognize how schedule changes affect passenger
reseating.
> Set up flight schedules and activate flights in the DCS
operational window.
> Manage the Schedule Entry Table (SET).
> Investigate and resolve issues, such as locked flights.

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Seat rules and their impact on seat maps
> Flight schedules and when they are triggered to Flight
Management
> Schedule Entry Table (SET)
> Schedule changes and passenger reseating
> Schedule business rules, both mandatory and
optional
> Business rules for DCS triggers and Res-DCS
exchange

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Awareness Yes No

Is this the course for you?
This course is for:
Airlines that implemented only Altéa DC-CM and Altéa DC-FM
and not the Altéa suite.

Things you need for this course
Pre-requisite: 
> Amadeus Altéa DC-CM Departure Plan Template &
Departure Control

> Amadeus Altéa DC-CM Business Rules

> Amadeus Altéa DC-FM Departure Plan Template &
Departure Control

> Amadeus Altéa DC-FM Business Rules

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM) 

> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa Inventory for Altéa DC-CM Standalone

[Instructor-Led] 

> Amadeus Altéa Inventory for Altéa DC-CM/FM standalone

[Instructor-Led] 

> Amadeus Altéa Inventory for Altéa DC-FM standalone

[Instructor-Led]   

How the course is organised
> 3 days instructor-led with practical exercises 

What equipment do you need?
> A phone (fixed-line, mobile not recommanded)

> A computer

> A good internet connection

The last few details...
> To schedule a customized session, please contact
learning@amadeus.com

> Last update: April 2026
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Instructor-Led
Amadeus Altéa Inventory for Altéa DC-FM
standalone
This course offers a comprehensive overview of Altéa Inventory's system architecture and its integration with Altéa
Departure Control - Flight Management, with an emphasis on seat management and scheduling. Participants will
engage in practical exercises to develop and maintain aircraft configurations, design seat maps, manage flight
schedules when flights are locked, and oversee the SET process.

In this course, you will learn:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Set up flight schedules and activate flights in Flight
Management.
> Investigate and resolve issues, such as locked flights
and manage Schedule Entry Table (SET).

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Flight schedules and when they are triggered to Flight
Management
> Manage Schedule Entry Table (SET)
> Schedule business rules, both mandatory and
optional
> Business rules for DCS triggers and Res-DCS
exchange

 

In this course, you will learn:
> Identify Altéa Inventory's system architecture.
> Navigate Altéa Inventory and Messenger viewer.
> Create seat maps and work with different templates.
> Set up flight schedules and activate flights in Flight
Management.
> Investigate and resolve issues, such as locked flights
and manage Schedule Entry Table (SET).

 

This course covers the following topics:
> Altéa Inventory's system architecture and Messenger
viewer 
> Market groups, flight groups, and business rules
> Seat maps and their templates
> Flight schedules and when they are triggered to Flight
Management
> Manage Schedule Entry Table (SET)
> Schedule business rules, both mandatory and
optional
> Business rules for DCS triggers and Res-DCS
exchange

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Awareness Yes No

Is this the course for you?
This course is for:
Airlines that implemented only Altéa DC-FM and not the Altéa
suite.

Things you need for this course
Pre-requisite: 
> Amadeus Altéa DC-FM Departure Plan Template &
Departure Control

> Amadeus Altéa DC-FM Business Rules

This course helps you use
> Altéa Departure Control - Flight Management (FM) 

> Altéa Inventory and Code Share   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led] 

> Amadeus Altéa Inventory Certification [Instructor-Led] 

> Amadeus Altéa Inventory for Altéa DC-CM Standalone

[Instructor-Led] 

> Amadeus Altéa Inventory for Altéa DC-CM/FM standalone

[Instructor-Led]   

How the course is organised
> 2 days instructor-led with practical exercises 

This course is also available in
English

What equipment do you need?
> A phone (fixed-line, mobile not recommanded)

> A computer

> A good internet connection

The last few details...
> To schedule a customised session, please contact
learning@amadeus.com

> Last update: April 2026
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Instructor-Led
Amadeus Altéa Inventory-DCS Links
This course gives a global view of the process flow, links and interactions between Altéa Reservation, Inventory,
Administration and Departure Control Customer Management and Flight Management, from flight creation to post
departure.

In this course you will learn:
> Explore the interactions among the five Altéa PSS
products, and how they work together within the airline
ecosystem.
> Examine the complete flight lifecycle and the
associated Altéa business process flow and end-to-end
operational framework.
> Manage flight disruptions fast and effectively using
reaccommodation/passenger transfer features through
hands-on exercises.

This course covers the following topics:
> Reviewing the Altéa solution system architecture.
> Buidling seat maps, creating schedules in Inventory.
> Reviewing the relevant Inventory and Departure
Control Business Rules.
> Reviewing the Departure Plan activities.
> Creating flights in Customer Management and Flight
Management.
> Identifying the data exchange between the PNR,
Inventory, and Departure Control.
> Working with common flight disruption scenarios
impacting Departure Control and PNRs.

In this course you will learn:
> Explore the interactions among the five Altéa PSS
products, and how they work together within the airline
ecosystem.
> Examine the complete flight lifecycle and the
associated Altéa business process flow and end-to-end
operational framework.
> Manage flight disruptions fast and effectively using
reaccommodation/passenger transfer features through
hands-on exercises.

This course covers the following topics:
> Reviewing the Altéa solution system architecture.
> Buidling seat maps, creating schedules in Inventory.
> Reviewing the relevant Inventory and Departure
Control Business Rules.
> Reviewing the Departure Plan activities.
> Creating flights in Customer Management and Flight
Management.
> Identifying the data exchange between the PNR,
Inventory, and Departure Control.
> Working with common flight disruption scenarios
impacting Departure Control and PNRs.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 5 days English Advanced Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline administrators, functional analysts, and business
process testers needing to know how the different Altéa
products interact with one another

Things you need for this course
Pre-requisite: 
Have successfully passed one of the courses below:

> Amadeus Altéa Inventory Certification
> Amadeus Altéa DC-CM Certification
> Amadeus Altéa DC-FM Certification

or completed one of the following e-learning:

> Amadeus Altéa Inventory awareness (6 hours 10 minutes)

> Amadeus Altéa DC-CM awareness (8 hours 50 minutes)

> Amadeus Altéa DC-FM awareness (2 hours 30 minutes)

Prework: 
Before attending this course, complete the following e-learning
to get familiar with our solutions:

> How Altéa Inventory interacts with other systems (20
minutes)

This course helps you use
> Altéa Administration 

> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM) 

> Altéa Inventory and Code Share 

> Altéa Reservation Desktop Essential   

Related courses
> Amadeus Altéa DC-FM Certification [Instructor-Led] 

> Amadeus Altéa Inventory Certification [Instructor-Led] 

> Amadeus Altéa DC-CM Certification [Instructor-Led]   

How the course is organised
> 5 days training 

What equipment do you need?
View our instructor-led requirements

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: February 2026
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Instructor-Led
Amadeus Altéa Messaging Server
This course describes how to correctly set up the Messenger viewer in Amadeus Altéa Inventory

On this course you will learn how to:
> Construct the Dispatch Rules
> Establish Subscriptions for users
> Enforce Message Duration where necessary
> Retrieve Messenger History

This course covers the following topics:
> Message publication process and main actors
involved.
> Category trees.
> Dispatch rules.
> Subscriptions.
> Message duration rules.
> Delegation.
> History.

On this course you will learn how to:
> Construct the Dispatch Rules
> Establish Subscriptions for users
> Enforce Message Duration where necessary
> Retrieve Messenger History

This course covers the following topics:
> Message publication process and main actors
involved.
> Category trees.
> Dispatch rules.
> Subscriptions.
> Message duration rules.
> Delegation.
> History.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour + 2 hours English Fundamentals Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Altéa Inventory Administrators or airline administrators.

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification

Prework: 
> Complete the following e-Learning path (1 hour):

Amadeus Messaging Server awareness

This prework is mandatory to attend this training

This course helps you use
> Altéa Administration 

> Altéa Inventory and Code Share   

How the course is organised
> 1 hour of e-Learning, mandatory to attend the virtual session.

> 2 hours of virtual Q&A training session

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: July 2025
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Instructor-Led
Amadeus Altéa NDC for Airlines
Amadeus Altéa NDC (New Distribution Capability) provides the end-to-end booking flows, from shopping to
purchasing, using NDC-Standard API to manage "full Offer & Order" capabilities.

On this course, you will learn how to:
> Describe Amadeus Altéa NDC.
> Identify NDC flows and APIs supported by Altéa
NDC.
> Perform baseline Altéa NDC flows (Prime Booking
Flow and Servicing flows) with the SoapUI API testing
tool.
> Log into and log-off from Altéa NDC Configuration
Manager UI.
> Navigate through Altéa NDC Configuration Manager
UI.
> Configure and control the partner or travel seller to
access your NDC contents.
> Provide best practice and investigation tips to your
NDC partners.

This course covers the following topics:
> Altéa NDC High Level Overview 
> Altéa NDC Connectivity and Configuration
> Altéa NDC Shopping
> Altéa NDC Prime Booking Flow
> Altéa NDC Servicing Flows
> Altéa NDC OrderChangeNotifcation
> Altéa NDC Reporting NDC Sales
> Altéa NDC Best Practice

On this course, you will learn how to:
> Describe Amadeus Altéa NDC.
> Identify NDC flows and APIs supported by Altéa
NDC.
> Perform baseline Altéa NDC flows (Prime Booking
Flow and Servicing flows) with the SoapUI API testing
tool.
> Log into and log-off from Altéa NDC Configuration
Manager UI.
> Navigate through Altéa NDC Configuration Manager
UI.
> Configure and control the partner or travel seller to
access your NDC contents.
> Provide best practice and investigation tips to your
NDC partners.

This course covers the following topics:
> Altéa NDC High Level Overview 
> Altéa NDC Connectivity and Configuration
> Altéa NDC Shopping
> Altéa NDC Prime Booking Flow
> Altéa NDC Servicing Flows
> Altéa NDC OrderChangeNotifcation
> Altéa NDC Reporting NDC Sales
> Altéa NDC Best Practice

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes No

Is this the course for you?
This course is for:
> Airline agents involved in NDC with functional expertise in
the airline's distribution strategy and technical XML
knowledge.

Things you need for this course
Pre-requisite: 
> Basic understanding of airline processes and Amadeus
Altéa solutions.

> Functional expertise in the airline's distribution strategy, e.g.,
fares, reservation, and ticketing.

> Technical XML knowledge.

This course helps you use
> Altéa NDC   

How the course is organised
> 3 days of training.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: February 2026
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Instructor-Led
Amadeus Availability Management
This course describes how to use Amadeus Availability Management to differentiate your availability offer in line
with your customer and market segmentation. By applying revenue management controls at channel level,
availability information can be tailored to individual points-of-sale.

On this course, you will learn to:
> Create and maintain points-of-sale.
> Set up flight groups.
> Define markets.
> Construct class suppression, polling, AVS-driven
rules, and functional access control rules.
> Read the history and restore historical items.
> Request access authorisation.

This course covers the following topics:
> Creating and maintaining Point-of-Sale keyword
definitions to target standard Amadeus users, internet
users and users in reverse access.
> Achieving expected distribution levels by managing
class suppression rules and AVS-driven rules, and
maintaining polling rules for dynamic availability.
> Retrieving and reading the history.

On this course, you will learn to:
> Create and maintain points-of-sale.
> Set up flight groups.
> Define markets.
> Construct class suppression, polling, AVS-driven
rules, and functional access control rules.
> Read the history and restore historical items.
> Request access authorisation.

This course covers the following topics:
> Creating and maintaining Point-of-Sale keyword
definitions to target standard Amadeus users, internet
users and users in reverse access.
> Achieving expected distribution levels by managing
class suppression rules and AVS-driven rules, and
maintaining polling rules for dynamic availability.
> Retrieving and reading the history.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2.5 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration.

Things you need for this course
Pre-requisite: 
Have successfully passed one of the below courses:

> Amadeus Reservation and Ticketing Web Certification for

New Users.

> Amadeus Altea Inventory Certification.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (5 minutes):

What is polling?

This course helps you use
> Airline Distribution 

> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Carrier Preferred Display Management

[Instructor-Led]   

How the course is organised
> 2.5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Business Analytics Center for Altéa Airlines
Business Analytics Center (BAC) provides easy access to relevant KPIs and dynamic commercial and operational
performance ready-to-use dashboards. This one single portal efficiently and autonomously defines your strategy,
sets your objectives, and measures their impacts afterwards using trusted data. This course explains how to use
Airline Business Analytics Center (BAC) features to prepare the business dashboards.

On this course, you will learn how to:
> Navigate through different modules in the Business
Analytics Center portal.
> Define your specific dashboards.
> Create a story.

This course covers the following topics:
> Business Analytics Center (BAC) 5 standard modules:
C-level, Bookings, Travelers, Revenue Management,
and On-Time Performance.
> Navigating BAC portal - QlikSense.
> Reviewing ready-to-visualize dashboards.
> Duplicating dashboard.
> Creating your own visualized dashboards.
> Using Bookmarks.
> Creating a story.

On this course, you will learn how to:
> Navigate through different modules in the Business
Analytics Center portal.
> Define your specific dashboards.
> Create a story.

This course covers the following topics:
> Business Analytics Center (BAC) 5 standard modules:
C-level, Bookings, Travelers, Revenue Management,
and On-Time Performance.
> Navigating BAC portal - QlikSense.
> Reviewing ready-to-visualize dashboards.
> Duplicating dashboard.
> Creating your own visualized dashboards.
> Using Bookmarks.
> Creating a story.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airline business decision makers.

> Airline advanced business analysts.

Things you need for this course
Pre-requisite: 
> Have a basic understanding of airline processes and
Amadeus Altéa solutions.

> Familiarity with airline business processes and task
distribution.

This course helps you use
> Business Analytics Center Portal   QlikSense   

How the course is organised
> 3 days training.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: August 2025
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Instructor-Led
Amadeus Carrier Preferred Display Management
This course explains how to use Amadeus Carrier Preferred Display Management to configure the content of your
biased display in the most profitable way for your Availability display worldwide, your website display or in
disruption scenarios. 

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules in
accordance with the product options Availability, Flex
Pricer. and Automatic Flight Selection
> Exclude flights, connections and airport changes
> Read the CPD rule's history
> Interpretate hierarchy and weighing
> Request product access

 This course covers the following topics:
> Points of sale in accordance with the product options
used
> Market definitions.
> Carrier Preferred rules reflecting either the airline's
distribution policy worldwide or for airline websites or
for the airline's disruption scenarios.
> Flight, connection and airport change exclusions
> CPD rule's history
> Hierarchy and weighting
> Certification test.

 

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules in
accordance with the product options Availability, Flex
Pricer. and Automatic Flight Selection
> Exclude flights, connections and airport changes
> Read the CPD rule's history
> Interpretate hierarchy and weighing
> Request product access

 This course covers the following topics:
> Points of sale in accordance with the product options
used
> Market definitions.
> Carrier Preferred rules reflecting either the airline's
distribution policy worldwide or for airline websites or
for the airline's disruption scenarios.
> Flight, connection and airport change exclusions
> CPD rule's history
> Hierarchy and weighting
> Certification test.

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration.

> Altéa Inventory airline users.

> Airline staff configuring CPD for their Availability display
worldwide, their website display and in disruption scenarios.

 

> Navitaire airlines and non-Altéa carriers should register to '

Amadeus Carrier Preferred Display Management for global,

web and on-line distribution'.

Things you need for this course
Pre-requisite: 
> Have a basic understanding of airline distribution processes,
Amadeus availability and schedule displays.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (5 minutes):

What are Carrier Preferred Display service flows

This course helps you use
> Airline Distribution   

Related courses
> Amadeus Availability Management [Instructor-Led] 

> Amadeus Altéa Inventory Certification [Instructor-Led]   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: July 2025
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Instructor-Led
Amadeus Carrier Preferred Display Management for
disruption, OCC, APR display
This course explains how to use Amadeus Carrier Preferred Display Management to configure the content of your
biased display in the most profitable way for Disruption / OCC operation control center / APR optimized passenger
recovery scenarios at the airport. 

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules for
disruption, OCC/APR displays.  
> Exclude flights, connections and airport changes.
> Read the history.
> Request product access.

 This course covers the following topics:
> Points of sale in accordance with the product options
used
> Markets 
> Carrier Preferred rules for your disruption, OCC/APR
displays and self re-accommodation
> Flight, connections or airport change exclusions
> CPD rule's history
> Hierarchy and weighting
> Product access.
> Certification test

 

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules for
disruption, OCC/APR displays.  
> Exclude flights, connections and airport changes.
> Read the history.
> Request product access.

 This course covers the following topics:
> Points of sale in accordance with the product options
used
> Markets 
> Carrier Preferred rules for your disruption, OCC/APR
displays and self re-accommodation
> Flight, connections or airport change exclusions
> CPD rule's history
> Hierarchy and weighting
> Product access.
> Certification test

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2.5 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airline staff configuring CPD in disruption scenarios

Things you need for this course
Pre-requisite: 
> Have a basic understanding of airline distribution processes,
Amadeus availability and schedule displays.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (5 minutes):

What are Carrier Preferred Display service flows

This course helps you use
> Airline Distribution   

Related courses
> Amadeus Availability Management [Instructor-Led]   

How the course is organised
> 2.5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: July 2025
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Instructor-Led
Amadeus Carrier Preferred Display Management Self
Re-accommodation
This course explains how to use Amadeus Carrier Preferred Display Management to configure the content of your
Self Re-accommodation websites.

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules for your Self
Re-accommodation websites.
> Exclude flights, connections and airport changes.

 This course covers the following topics:
> Point of sales for self re-accommodation websites
> Markets
> Carrier Preferred rules reflecting your rebooking
scenarios for self re-acc websites.
> Flight, connection and airport change exclusions 

 On this course you will learn how to:
> Create and maintain points of sale.
> Set up and modify markets.
> Construct Carrier Preferred Display rules for your Self
Re-accommodation websites.
> Exclude flights, connections and airport changes.

 This course covers the following topics:
> Point of sales for self re-accommodation websites
> Markets
> Carrier Preferred rules reflecting your rebooking
scenarios for self re-acc websites.
> Flight, connection and airport change exclusions 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1.5 days English Advanced Yes Yes

Is this the course for you?
This course is for:
> Airlines in Self Re-acc migration.

> Airline staff configuring CPD for their self
re-accommodation websites.

Things you need for this course
Pre-requisite: 
> Have a basic understanding of airline distribution processes,
Amadeus availability and schedule displays.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (5 minutes) and its quiz:

What are Carrier Preferred Display service flows

This course helps you use
> Airline Distribution   

Related courses
> Amadeus Availability Management [Instructor-Led] 

> Amadeus Altéa Inventory Certification [Instructor-Led]   

How the course is organised
> 1.5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: July 2025
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Instructor-Led
Amadeus Digital Awards
This course focuses on how to configure Cash to Miles conversion rules through the Amadeus FareXpert filing
platform. The conversion rate defined in these rules can feed an airline's online channel (Digital Awards) or the
offline channel (ARD Web) or both. It allows frequent travellers to book air travel and settle the price of a ticket
either in currency, or in miles, or in a combination of both.

 On this course you will learn how to:
> Describe the Award Converter and the Miles & Cash
slider logic.
> Access to the 'Cash to Miles conversion' module in
FareXpert.
> Create, duplicate, edit a conversion rule for
commercial and redemption booking classes.
> Create adhoc promotions.
> Differentiate the conversion process of fares from the
one for Ancillary Services and Taxes.
> Create specific conversion rules for Marginal fares.

This course covers the following topics: 
> Product overview of the Digital Awards suite
(Converter Engine, Award converter and Miles & Cash
slider)
> How to access the FareXpert Cash to Miles
conversion module.
> How to create cash to miles conversion rules (various
use case scenarios).

 On this course you will learn how to:
> Describe the Award Converter and the Miles & Cash
slider logic.
> Access to the 'Cash to Miles conversion' module in
FareXpert.
> Create, duplicate, edit a conversion rule for
commercial and redemption booking classes.
> Create adhoc promotions.
> Differentiate the conversion process of fares from the
one for Ancillary Services and Taxes.
> Create specific conversion rules for Marginal fares.

This course covers the following topics: 
> Product overview of the Digital Awards suite
(Converter Engine, Award converter and Miles & Cash
slider)
> How to access the FareXpert Cash to Miles
conversion module.
> How to create cash to miles conversion rules (various
use case scenarios).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS or standalone migration

> Airline Fares and Pricing administrators, loyalty programme
administrators, online booking tool administrators.

Things you need for this course
Pre-requisite: 
> Basic understanding of Amadeus Redemption and Cash &
Miles flow solutions

> Basic understanding of Fares & Pricing

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: January 2025
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Instructor-Led
Amadeus Document Management for ARD Web &
SAPE
This course explains how to setup the standalone print emulator in the Altea Admin GUI and it covers the
installation of Amadeus Peripheral Manager, SAPE including the launch of ARD Web.

On this course, you will learn how to:
> Determine the concepts used in Altea Administration
for Device Administration
> Complete the 4-steps auto-registration process to
print documents through the Amadeus host
> Install Amadeus Peripheral Manager and SAPE
(Standalone Print Emulator)
> Request access to Altea Administration

This course covers the following topics:
>  Auto-registration of printing devices i.e Laser or Dot
Matrix
>  Peripheral manager & SAPE installation

On this course, you will learn how to:
> Determine the concepts used in Altea Administration
for Device Administration
> Complete the 4-steps auto-registration process to
print documents through the Amadeus host
> Install Amadeus Peripheral Manager and SAPE
(Standalone Print Emulator)
> Request access to Altea Administration

This course covers the following topics:
>  Auto-registration of printing devices i.e Laser or Dot
Matrix
>  Peripheral manager & SAPE installation

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 0.5 day English Awareness Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline Administrators, IT Support or Helpdesk agents in
charge of print devices configuration for ARD Web or Web
Essentials

Things you need for this course
Pre-requisite: 
> Knowledge about printing solutions

This course helps you use
> Altéa Document Management   

Related courses
> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led]   

How the course is organised
> 1 virtual session of 2.5 hours

What equipment do you need?
View our instructor-led requirements.

The last few details...
> For a customised or dedicated session, please contact your
Amadeus training consultant: learning@amadeus.com

> Last Update: April 2022
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Instructor-Led
Amadeus e-Retail Engine for New Users
This course describes how a booking engine works and interacts with the reservation system whether as a
standalone solution or integrated into an external website.

During this course you will learn how to:
> Use the online booking engine
> Configure Site Manager
> Differentiate between the different search flows
> Follow the steps of the Workflow Manager
> List the different digital solutions available
> Navigate through the test and validation tool called
the HTML shooter

 

 

This course covers the following topics:
> Overview of e-Retail Engine concepts and
terminology
> Implementation process
> Schedule driven and Fare driven booking flows
> Introduction to Site Manager
> Basic Site Manager exercises
> Enhancing the offerings of a site
> Options to customise a site
> Light overview on how to integrate e-Retail with an
external website (Connectors)
> Use the test and validation tool called the HTML
shooter
> Booking insurance in-Retail Engine

During this course you will learn how to:
> Use the online booking engine
> Configure Site Manager
> Differentiate between the different search flows
> Follow the steps of the Workflow Manager
> List the different digital solutions available
> Navigate through the test and validation tool called
the HTML shooter

 

 

This course covers the following topics:
> Overview of e-Retail Engine concepts and
terminology
> Implementation process
> Schedule driven and Fare driven booking flows
> Introduction to Site Manager
> Basic Site Manager exercises
> Enhancing the offerings of a site
> Options to customise a site
> Light overview on how to integrate e-Retail with an
external website (Connectors)
> Use the test and validation tool called the HTML
shooter
> Booking insurance in-Retail Engine

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes No

Is this the course for you?
This course is for:
> Staff managing an airline's direct online sales channel
(www.airline.com)

> Airlines in PSS or standalone migration

Things you need for this course
Pre-requisite: 
> Basic knowledge on GDS (not a must)

> Be familiar with an online booking tool

This course helps you use
> Amadeus e-Retail 

> Amadeus Flex Pricer   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: July 2024
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Instructor-Led
Amadeus FareXpert Dynamic Fares
This course explains how to use Amadeus FareXpert Dynamic Fares to create discounts based on existing
published, private and negotiated fares.

On this course you will learn how to:
>  Create discounts based on passenger type codes,
fare type codes, international and domestic fare types.

This course covers the following topics:
> Dynamic Fare Overview.
> Create Promotion Fares.
> Create Vendor Aggregate.
> Create Promotion Fares with Rule Conditions, ATPCO
CAT 15 Private Fares and Amadeus FareXpert.

On this course you will learn how to:
>  Create discounts based on passenger type codes,
fare type codes, international and domestic fare types.

This course covers the following topics:
> Dynamic Fare Overview.
> Create Promotion Fares.
> Create Vendor Aggregate.
> Create Promotion Fares with Rule Conditions, ATPCO
CAT 15 Private Fares and Amadeus FareXpert.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

Things you need for this course
Pre-requisite: 
Bring a basic knowledge of fares and fare filing, as well
as Amadeus PNR creation.

Have successfully passed the following course:

> Amadeus Farexpert Negotiated Fares.

This course helps you use
> Amadeus FareXpert   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements.

The last few details...
Important to note: The Amadeus FareXpert filing platform is a
set of applications (modules) which enable real-time filing into
the Amadeus database. For productivity and consistency
purposes, all applications have been grouped under this
platform. Every FareXpert based module addresses a specific
filing need and thus targets potentially very different
audiences. It is therefore key to cleary identify to which
FareXpert module reference is being made. The Amadeus
FareXpert Dynamic Fares training course is covering the
FareXpert based Promotions module.

> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Flex Pricer
This course describes how Flex Pricer as a shopping engine fits into airline direct distribution channels (digital
'.com', NDC, Call-Center, Group Management). Main focus during this course is how to access and administer the
FareXpert based Airlines Fare Families module.

On this course, you will:
> Identify Flex Pricer concepts, terminology and
architecture.
> Create Commercial Fare Families (CFF), Markets, and
Fare Families (FF) using the Amadeus FareXpert filing
platform
> Explain the interdependancies of updates in
FareXpert and the administration tool of the front-end
application (e.g. Site Manager).

This course covers the following topics:
> Flex Pricer specific terminology and architecture.
> How to access the Airlines Fare Families module
based on the Amadeus FareXpert filing platform.
> How to create a Commercial Fare Family, Markets,
and Fare Families.
> How to use Location-, Vendor-, and Market
Aggregates within FareXpert.
> How updates in FareXpert impact the administration
tool of the front-end application (e.g.: Site Manager).
> Note: Flex Pricer and/or the FareXpert based Fare
Families modules can be used in an airline direct
(online) channel, and in other contexts such as: ARD
Web, NDC, Amadeus Group Manager

On this course, you will:
> Identify Flex Pricer concepts, terminology and
architecture.
> Create Commercial Fare Families (CFF), Markets, and
Fare Families (FF) using the Amadeus FareXpert filing
platform
> Explain the interdependancies of updates in
FareXpert and the administration tool of the front-end
application (e.g. Site Manager).

This course covers the following topics:
> Flex Pricer specific terminology and architecture.
> How to access the Airlines Fare Families module
based on the Amadeus FareXpert filing platform.
> How to create a Commercial Fare Family, Markets,
and Fare Families.
> How to use Location-, Vendor-, and Market
Aggregates within FareXpert.
> How updates in FareXpert impact the administration
tool of the front-end application (e.g.: Site Manager).
> Note: Flex Pricer and/or the FareXpert based Fare
Families modules can be used in an airline direct
(online) channel, and in other contexts such as: ARD
Web, NDC, Amadeus Group Manager

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in a PSS migration

> Airline staff involved in decision making around which fares /
brands should be filed and promoted through the direct online
distribution channels ('.com', NDC, Groups or Call-Center).

> The course is key for those staff members having to use
FareXpert to create and administer Commercial Fare Families
(CFF), Markets and Fare Families (FF).

Things you need for this course
Pre-requisite: 
> Basic understanding of Fares and Fare filing

> Understanding of airline's direct distribution channels
(website '.com', NDC, Groups, Call-Center).

This course helps you use
> Amadeus e-Retail 

> Amadeus FareXpert 

> Amadeus Flex Pricer 

> Digital Experience Suite (DES)   

Related courses
> Amadeus e-Retail Engine for New Users [Instructor-Led]   

How the course is organised
> 2 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> Important to note: The Amadeus FareXpert filing platform is
a set of applications enabling real-time filing into the Amadeus
database. Every FareXpert based module addresses a
specific filing need and targets potential different audiences.
The Flex Pricer training course is covering the FareXpert based
Airlines Fare Families.

> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Negotiated Space Certification
This course explains how to use Amadeus Negotiated Space to best define blocked space and assign it to
preferred travel agents, while retaining full synchronisation with your inventory system. This is an essential feature
for your distribution to cruise lines, tour operators and other consolidators.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to:
> Set up and maintain points of sale for handling tables
and block management.
> Define availability and sell options.
> Create and maintain Negotiated Space handling table
parameters.
> Create and modify Negotiated Space blocks.
> Retrieve and read the history.
> Run dashboards or reports.
> Request access authorisation.

This course covers the following topics:
> Creating and maintaining handling records.
> Setting up and modifying the Point of Sale.
> Creating and modifying Amadeus Negotiated Space
blocks.
> Reading the history.
> Running dashboards or reports.
> Requesting access to the product.
> Certification test.

On this course, you will learn how to:
> Set up and maintain points of sale for handling tables
and block management.
> Define availability and sell options.
> Create and maintain Negotiated Space handling table
parameters.
> Create and modify Negotiated Space blocks.
> Retrieve and read the history.
> Run dashboards or reports.
> Request access authorisation.

This course covers the following topics:
> Creating and maintaining handling records.
> Setting up and modifying the Point of Sale.
> Creating and modifying Amadeus Negotiated Space
blocks.
> Reading the history.
> Running dashboards or reports.
> Requesting access to the product.
> Certification test.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline Group or Negotiated Space Managers

Things you need for this course
Pre-requisite: 
We strongly recommend that the participants first attend
some of the below courses:

> Amadeus Reservation and Ticketing Web Certification for

New Users.

> Amadeus Altea Inventory Certification.

> Amadeus Availability Management. 

> Amadeus Carrier Preferred Display.

This course helps you use
> Airline Distribution 

> Altéa Reservation Desktop Essential   

Related courses
> Amadeus Availability Management [Instructor-Led]   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: June 2025
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e-Learning
Amadeus Office Management
As a security administrator, control office security access across all Amadeus systems.

On this course, you will learn: 
> How to manage offices
> How to manage terminals
> How to manage printers
> How to manage printer Sets 
> How to manage certificates 

Through a set of interactive lessons learn how to
manage offices, terminals, printers, printer-sets and
certificates using the web-based interface Amadeus
Office Management (AOM).

On this course, you will learn: 
> How to manage offices
> How to manage terminals
> How to manage printers
> How to manage printer Sets 
> How to manage certificates 

Through a set of interactive lessons learn how to
manage offices, terminals, printers, printer-sets and
certificates using the web-based interface Amadeus
Office Management (AOM).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 hours English Awareness No No

Is this the course for you?
This course is for:
Airlines, Ground Handlers

In particular, those working in:
Administrators, Business & Projects Managers, Help Desk &
Support Agents, Security Administrators, Trainers

This course helps you use
> Amadeus Office Management (AOM)   

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

The last few details...
To get access to AOM, you will need to complete a 2-days
instructor-led training and successfully pass the test.
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Instructor-Led
Amadeus Office Management Certification for
Airlines
This course explains how to manage office identifiers and office profiles using Amadeus Office Management
(AOM), to search, update and delete office configurations using the application.
You will practice using hands-on exercises leading to a certification test.

On this course you will learn how to:
> Configure agency access to the Amadeus
Reservation System using secured and controlled
environments.

This course covers the following topics:
> Create and setup office IDs and office profiles.
> Create reports and templates for massive actions.
> Review the user authentication process flow.

On this course you will learn how to:
> Configure agency access to the Amadeus
Reservation System using secured and controlled
environments.

This course covers the following topics:
> Create and setup office IDs and office profiles.
> Create reports and templates for massive actions.
> Review the user authentication process flow.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 2 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline security administrators who will update offices.

Things you need for this course
Pre-requisite: 
> Familiarity with airline business processes and task
distribution.

> Practical knowledge of ticketing and refund processes.

> Basic knowledge of Amadeus Information System pages.

Prework: 
To ensure that you are familiar with these products before
attending the course, we recommend you complete:

> Amadeus Office Management awareness (1 hour)

> Amadeus Security Management awareness (1 hour)

> Local Security Management (30mins) if your airline uses it.

This course helps you use
> Amadeus Office Management (AOM) 

> Amadeus Revenue Accounting   

Related courses
> Amadeus Security Management Certification for Altéa

Airlines [Instructor-Led]   

How the course is organised
> 2 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: August 2025
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Instructor-Led
Amadeus Passenger Name Manager
This course explains how to manage your name elements firming policies in a way that matches your sales
strategies. 

On this course, you will learn how to:
> Create rules to define corrective actions and/or
notification actions that will be triggered by a name
modification in PNRs.

This course covers the following topics:
> Product overview.
> Creation of Point Of Sale, markets and flight groups.
> Creation and administration of rules for individual and
group PNRs.

On this course, you will learn how to:
> Create rules to define corrective actions and/or
notification actions that will be triggered by a name
modification in PNRs.

This course covers the following topics:
> Product overview.
> Creation of Point Of Sale, markets and flight groups.
> Creation and administration of rules for individual and
group PNRs.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline administrators dealing with revenue integrity,
reservation and/or inventory

Things you need for this course
Pre-requisite: 
> You need a basic understanding of airline distribution
processes, and Amadeus Availability Display, and PNR.

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW)   

How the course is organised
> 2 virtual training sessions of 2.5 hours.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2023
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e-Learning
Amadeus Process Customer Value for Customer
Management
As an airline administrator, learn how Process Customer Value recommends onloading standby customers by
exploring the Enhanced Onload Recommendation features.

You will learn:
> What is an enhanced onload recommendation?
> How to onload a standby customer only to their
entitled cabin or a lower cabin
> How to make space for a standby customer by only
considering a downgrade
> How to make space for a standby customer by first
considering a downgrade
> How to make space for a standby customer by first
considering an upgrade

Through a set of e-learning, understand what Process
Customer Value for Customer Management is, what the
four enhanced onload recommendation options are,
how they onload and make space for a stand by
customer, and what their advantages and limitations
are.

You will learn:
> What is an enhanced onload recommendation?
> How to onload a standby customer only to their
entitled cabin or a lower cabin
> How to make space for a standby customer by only
considering a downgrade
> How to make space for a standby customer by first
considering a downgrade
> How to make space for a standby customer by first
considering an upgrade

Through a set of e-learning, understand what Process
Customer Value for Customer Management is, what the
four enhanced onload recommendation options are,
how they onload and make space for a stand by
customer, and what their advantages and limitations
are.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 40 minutes English Awareness No Yes

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Digital Experience Analysts, Help Desk &
Support Agents, Trainers

Things you need for this course
Prework: 
Altéa Departure Control - Customer Management awareness
learning path

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Amadeus Process Customer Value   

Related courses
> Altéa Departure Control - Customer Management

[e-Learning]   

How the course is organised
There are five mandatory e-learning lessons with knowledge
checks. After completion, there is a user guide available for
download. 

This course is also available in
English

What equipment do you need?
> A computer, laptop, or tablet.

> A high-speed internet connection (> 1MB).

> Google Chrome browser or alternatively the Microsoft Edge
browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.
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Instructor-Led
Amadeus Process Customer Value for Customer
Management
This course explains how to set up the customer ranking rules to prioritise customers during the onload/seating
regrade process on the Amadeus Retailing Platform.

On this course you will learn how to:
> Working with customer ranking process - Process
Customer Value (PCV).
> Navigating the PCV user interface.
> Constructing acceptance onload and regrade rules.
> Positioning and setting the ranking parameters and
verifying the results in Altéa Departure Control
Customer Management.

This course covers the following topics:
> How to access the Amadeus Retailing Platform.
> The purpose of customer ranking.
> The customer ranking process.
> Process Customer Value calculation (business
process, parameters).
> Using Market and Flight Group Management.
> Applying Global PCV.

On this course you will learn how to:
> Working with customer ranking process - Process
Customer Value (PCV).
> Navigating the PCV user interface.
> Constructing acceptance onload and regrade rules.
> Positioning and setting the ranking parameters and
verifying the results in Altéa Departure Control
Customer Management.

This course covers the following topics:
> How to access the Amadeus Retailing Platform.
> The purpose of customer ranking.
> The customer ranking process.
> Process Customer Value calculation (business
process, parameters).
> Using Market and Flight Group Management.
> Applying Global PCV.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline administrators responsible for setting up Customer
Management onload/regrade procedure.

Things you need for this course
Pre-requisite: 
Have successfully passed one of these courses:

> Altéa Departure Control - Customer Management

awareness e-Learning (9 hours)

> Amadeus Altéa DC-CM certification course.

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Amadeus Application Launcher   

How the course is organised
> 1 day training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Process Customer Value for Inventory
This course describes the Process Customer Value (PCV) application that is accessed via the Amadeus Application
Launcher and used by processes within Amadeus Altéa Inventory, and Amadeus Reservations. The purpose of
PCV for Inventory is to enable the passenger ranking on a waitlist confirmation.

On this course, you will learn how to set up the waitlist
confirmation Process Customer Value (PCV) rule in line
with your airline business objectives.

This course covers the following topics:
> How to create and maintain business rules for
qualifying and ranking passengers.
> Demonstration of PCV with business scenarios.
> Prioritisation for auto waitlist clearance process.
> Exercises on creating and validating rules in an
automated waitlist scenario

On this course, you will learn how to set up the waitlist
confirmation Process Customer Value (PCV) rule in line
with your airline business objectives.

This course covers the following topics:
> How to create and maintain business rules for
qualifying and ranking passengers.
> Demonstration of PCV with business scenarios.
> Prioritisation for auto waitlist clearance process.
> Exercises on creating and validating rules in an
automated waitlist scenario

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 25 minutes + 3 hours English Fundamentals Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

Things you need for this course
Pre-requisite: 
> Have successfully passed one of the following courses:

Amadeus Altéa Inventory Certification
Schedule Management Certification
Inventory Management Certification

Prework: 
> Complete the following e-Learning:

What is Automatic Waitlist Clearance? (10min)

How is Process Customer Value (PCV) determined (15min)
+ the questionnaire which the trainer will send to you

This prework is mandatory to attend this training

This course helps you use
> Altéa Inventory and Code Share   

How the course is organised
> 25min of e-Learning: Automatic Waitlist Clearance + PCV +
questionnaire (sent by your trainer), mandatory to attend the
virtual session.

> 3 hours of virtual session

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Queues
This course explains how to display and process Amadeus queues for the airline reservation and ticketing agents
who are responsible for creating and maintaining queues in their organisation.

On this course, you will learn how to:
> Display and interpret a queue bank.
> Navigate queues within Altéa Reservation.
> Process PNRs and messages stored in queues.
> Create, customise, and delete queues and categories.
> Utilise the queue planner and count reset.

 

This course covers the following topics:
> Queue Navigation
> Queue Bank
> PNR and Messages Queues
> Queue Categories
> Queue Planner

On this course, you will learn how to:
> Display and interpret a queue bank.
> Navigate queues within Altéa Reservation.
> Process PNRs and messages stored in queues.
> Create, customise, and delete queues and categories.
> Utilise the queue planner and count reset.

 

This course covers the following topics:
> Queue Navigation
> Queue Bank
> PNR and Messages Queues
> Queue Categories
> Queue Planner

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes Yes

Is this the course for you?
This course is for:
Airline members that will be responsible for working and
maintaining queues for their organization

Things you need for this course
Pre-requisite: 
> A basic knowledge of Passenger Name Records (PNR).

> 

Have successfully passed one of the below courses:

> Amadeus Reservation and Ticketing Web Certification for

New Users.

> Amadeus Reservation and Ticketing Cryptic Certification.

Prework: 
If you have not passed one of the courses above:

> Complete the following e-Learning lesson (3 hours): Altéa

Reservation and Ticketing (Cryptic) awareness

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led] 

> Amadeus Reservation and Ticketing Web

Certification-Conversion from Amadeus Cryptic to Graphic

[Instructor-Led]   

How the course is organised
> 1 day of virtual or classroom training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: February 2026
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Instructor-Led
Amadeus Reservation and Ticketing Cryptic - EMDs
Advanced 
This course builds upon the cryptic certification course by exploring complex scenarios for effective problem
solving using hands-on exercises. You will improve your ability to manage EMD processes in the cryptic window.

In this course you will learn how to:
> Create financial EMDs for penalty fees and residual
value in the cryptic window (command page).

This course covers the following higher-level topics:
> EMD creation for: Penalty fees, No Show fees,
Cancellation fees, & Deposit (Group PNRs)
> EMD RSVT after reissue process
> EMD RSVR after reissue process
> EMD RSVT partially used on future booking with new
RSVT issuance
> EMD RSVT used on future booking with additional
collection
> EMD RSVR refund

In this course you will learn how to:
> Create financial EMDs for penalty fees and residual
value in the cryptic window (command page).

This course covers the following higher-level topics:
> EMD creation for: Penalty fees, No Show fees,
Cancellation fees, & Deposit (Group PNRs)
> EMD RSVT after reissue process
> EMD RSVR after reissue process
> EMD RSVT partially used on future booking with new
RSVT issuance
> EMD RSVT used on future booking with additional
collection
> EMD RSVR refund

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Advanced Yes No

Is this the course for you?
This course is for:
Any airline user with at least 6 months of experience using the
cryptic window (command page):

> Airline help desk agents

> Airline trainers

> Airline reservation and ticketing agents

Things you need for this course
Pre-requisite: 
> Have successfully passed Amadeus Reservation and

Ticketing Cryptic Certification for new users.

Or

> Have passed the Test: Amadeus Reservation and Ticketing

Cryptic - EMDs Advanced.

This course helps you use
> Altéa Reservation Desktop Essential   

Related courses
> Amadeus Reservation and Ticketing Cryptic Certification

[Instructor-Led] 

> Amadeus Reservation and Ticketing Cryptic - Manual

Reissues Advanced  [Instructor-Led]   

How the course is organised
> 2 days training on EMDs

> 1 hour knowledge test

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Reservation and Ticketing Cryptic - Manual
Reissues Advanced 
This course builds upon the cryptic certification course by exploring complex scenarios for effective problem
solving using hands-on exercises. You will improve your ability to manage manual reissue processes in the cryptic
window.

In this course you will learn how to:
> Execute the required steps to process manual
reissues in the cryptic window (command page).
> Perform all possible scenarios for involuntary and
voluntary reissues.

This course covers the following higher-level topics:

Manual involuntary reissue due to:
> A change of cabin/airline/routing
> An outbound diversion
> A change of name (airline agent mistake)

Manual voluntary reissue due to:
> A change of name with and without fees
> A change of route with additional collection and
penalty fees
> A change of route with residual value for future air
transportation (RSVT)
> A change of cabin
- upgrade with penalty fee
- downgrade with residual value for refund (RSVR)

In this course you will learn how to:
> Execute the required steps to process manual
reissues in the cryptic window (command page).
> Perform all possible scenarios for involuntary and
voluntary reissues.

This course covers the following higher-level topics:

Manual involuntary reissue due to:
> A change of cabin/airline/routing
> An outbound diversion
> A change of name (airline agent mistake)

Manual voluntary reissue due to:
> A change of name with and without fees
> A change of route with additional collection and
penalty fees
> A change of route with residual value for future air
transportation (RSVT)
> A change of cabin
- upgrade with penalty fee
- downgrade with residual value for refund (RSVR)

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Advanced Yes No

Is this the course for you?
This course is for:
Any airline user with at least 6 months of experience using the
cryptic window (command page):

> Airline help desk agents

> Airline trainers

> Airline reservation and ticketing agents

Things you need for this course
Pre-requisite: 
> Have successfully passed Amadeus Reservation and

Ticketing Cryptic Certification for new users.

Or

> Have passed the Test: Amadeus Reservation and Ticketing

Cryptic - Manual Reissues Advanced.

This course helps you use
> Altéa Reservation Desktop Essential   

Related courses
> Amadeus Reservation and Ticketing Cryptic Certification

[Instructor-Led] 

> Amadeus Reservation and Ticketing Cryptic - EMDs

Advanced  [Instructor-Led] 

> Amadeus Smart Flows [Instructor-Led]   

How the course is organised
> 2 days training on manual reissues

> 1 hour knowledge test

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Reservation and Ticketing Cryptic
Certification
This course explains how to use cryptic window of the Amadeus Reservation Desktop Web solution and perform
actions not available in the graphical user interface.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn to:
> Use cryptic entries to access airline content
distributed in Altéa Reservation.

This course covers the following topics:
> Amadeus Information Pages and online help
> Availability, schedule and timetable displays
> Passenger Name Record (PNR) creation and
modification
> Introduction to Amadeus Queues
> Amadeus Fare Quote
> PNR pricing
> Issuing and revalidating tickets
> Voluntary and involuntary reissues
> Full and partial refunds
> Electronic Miscellaneous Documents (EMD)
> Electronic document management

On this course, you will learn to:
> Use cryptic entries to access airline content
distributed in Altéa Reservation.

This course covers the following topics:
> Amadeus Information Pages and online help
> Availability, schedule and timetable displays
> Passenger Name Record (PNR) creation and
modification
> Introduction to Amadeus Queues
> Amadeus Fare Quote
> PNR pricing
> Issuing and revalidating tickets
> Voluntary and involuntary reissues
> Full and partial refunds
> Electronic Miscellaneous Documents (EMD)
> Electronic document management

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 5 days English Certification Yes No

Is this the course for you?
This course is for:
> Airline staff using Amadeus Altéa Reservation Desktop.

> Airline business developers, helpdesk and trainers.

Things you need for this course
Pre-requisite: 
Complete the following e-learning:

Altea Reservation and Ticketing (Cryptic) awareness

This course helps you use
> Altéa Reservation Desktop Essential   

How the course is organised
> 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> This course is available on request only.

> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: May 2025
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Instructor-Led
Amadeus Reservation and Ticketing Help Desk for
Airlines
This course explains how to support your customers' reservation and ticketing agents in solving their daily issues. It
concentrates on the functional and technical system settings that agents need to verify before contacting the
Second-level Help Desk.

 On this course you will learn how to: 
> Use features available to Help Desks for identifying
and solving problems
> Maximize the use of the Service Hub and the different
support touchpoints
> Assist end users with central system functionality and
database problems
> Describe the Amadeus system processing and
communication flows
> React accurately to specific system responses
> Identify issues and assign them to appropriate
Amadeus groups
> Follow the procedures to report incidents

This course covers the following topics:
> Incident handling and reporting
> Service Hub Support Touchpoints
> The distribution system architecture
> Office IDs and Office profiles
> Extended Ownership Security
> Amadeus Air
> Ticketing

 On this course you will learn how to: 
> Use features available to Help Desks for identifying
and solving problems
> Maximize the use of the Service Hub and the different
support touchpoints
> Assist end users with central system functionality and
database problems
> Describe the Amadeus system processing and
communication flows
> React accurately to specific system responses
> Identify issues and assign them to appropriate
Amadeus groups
> Follow the procedures to report incidents

This course covers the following topics:
> Incident handling and reporting
> Service Hub Support Touchpoints
> The distribution system architecture
> Office IDs and Office profiles
> Extended Ownership Security
> Amadeus Air
> Ticketing

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 hours + 5 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline Help Desk agents

Things you need for this course
Pre-requisite: 
> For airlines newcomers:
- Complete Altéa Reservation and Ticketing Helpdesk (3h)
- And successfully pass the included Awareness test (1h)
- Or complete the ARD Web for New Users course.

> For airlines in PSS migration:
- Complete the ARD Web for New Users course.

Prework: 
> Complete the Amadeus Incident Management e-Learning

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Security Management Certification for Altéa

Airlines [Instructor-Led] 

> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led]   

How the course is organised
> For airlines newcomers:
- 3 hours of e-Learning + online Awareness test
- 5 days training

> For airlines in PSS migration:
- 1 hour of Amadeus Incident Management e-Learning
- 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:
learning@amadeus.com

> Last update: June 2025
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Instructor-Led
Amadeus Reservation and Ticketing Web - EMDs
Advanced
This course builds upon the ARDW certification course by exploring complex scenarios related to EMD processes in
ARD Web for effective problem solving with the use of hands-on exercises.

In this course you will learn how to:
> Create financial EMDs for penalty fees and residual
value in ARD Web.

This course covers the following higher-level topics:
> EMD creation for: Penalty fees, No Show fees,
Cancellation fees, & Deposit (Group PNRs)
> EMD RSVT after reissue process
> EMD RSVR after reissue process
> EMD RSVT partially used on future booking with new
EMD RSVT issuance
> EMD RSVT used on future booking with additional
collection
> EMD RSVR refund

In this course you will learn how to:
> Create financial EMDs for penalty fees and residual
value in ARD Web.

This course covers the following higher-level topics:
> EMD creation for: Penalty fees, No Show fees,
Cancellation fees, & Deposit (Group PNRs)
> EMD RSVT after reissue process
> EMD RSVR after reissue process
> EMD RSVT partially used on future booking with new
EMD RSVT issuance
> EMD RSVT used on future booking with additional
collection
> EMD RSVR refund

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Advanced Yes No

Is this the course for you?
This course is for:
Any airline user with at least 6 months of experience using
Amadeus Reservation Desktop Web:

> Airline help desk agents

> Airline trainers

> Airline reservation and ticketing agents

Things you need for this course
Pre-requisite: 
> Have successfully passed Amadeus Reservation and

Ticketing Web Certification for new users.
Or

> Have passed the Test: Amadeus Reservation and Ticketing

Web - EMDs Advanced.

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led]   

How the course is organised
> 2 days training on EMDs

> 1 hour knowledge test

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Reservation and Ticketing Web - Manual
reissues Advanced
This course builds upon the ARDW certification course by exploring complex scenarios related to manual reissue
processes in ARD Web for effective problem solving with the use of hands-on exercises.

In this course you will learn how to:
> Execute the required steps to process manual
reissues in Amadeus Reservation Desktop Web using
guided flows.
> Perform all possible scenarios for involuntary and
voluntary reissues.

This course covers the following higher-level topics:

Manual involuntary reissue due to:
> A change of cabin/airline/routing
> An outbound diversion
> A change of name (airline agent mistake)

Manual voluntary reissue due to:
> A change of name free of charge
> A change of route with additional collection and
penalty fees
> A change of route with residual value for Future Air
Transportation
> A change of cabin - upgrade with penalty fee
> A downgrade with residual value for refund

In this course you will learn how to:
> Execute the required steps to process manual
reissues in Amadeus Reservation Desktop Web using
guided flows.
> Perform all possible scenarios for involuntary and
voluntary reissues.

This course covers the following higher-level topics:

Manual involuntary reissue due to:
> A change of cabin/airline/routing
> An outbound diversion
> A change of name (airline agent mistake)

Manual voluntary reissue due to:
> A change of name free of charge
> A change of route with additional collection and
penalty fees
> A change of route with residual value for Future Air
Transportation
> A change of cabin - upgrade with penalty fee
> A downgrade with residual value for refund

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Advanced Yes No

Is this the course for you?
This course is for:
Any airline user with at least 6 months of experience using
Amadues Reservation Desktop Web:

> Airline help desk agents

> Airline trainers

> Airline reservation and ticketing agents

Things you need for this course
Pre-requisite: 
> Have successfully passed Amadeus Reservation and

Ticketing Web Certification for new users.
Or

> Have passed the Test: Amadeus Reservation and Ticketing

Web - Manual Reissues Advanced.

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led] 

> Amadeus Smart Flows [Instructor-Led]   

How the course is organised
> 2 days training on manual reissues

> 1 hour knowledge test

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Reservation and Ticketing Web
Certification for New Users
This course explains how to use the graphical user interface of Amadeus Altéa Reservation Desktop Web (ARD and
targets new users who do not have cryptic knowledge.
You will practice using hands-on exercises leading to a certification test.

On this course you will learn how to:
> Use the graphical environment of Altéa Reservation
Desktop Web (ARDW).
> Improve customer service with best practices.

This course covers the following topics:
> Understanding the ARDW environment and
architecture.
> Requesting an availability, informative
pricing, schedule and timetable display.
> Creating a Passenger Name Record (PNR).
> Modifying a PNR and interpreting its history.
> Working with Queues.
> Displaying fare information and pricing PNRs.
> Issuing, revalidating and reissuing e-tickets.
> Issuing, reissuing and managing EMDs.
> Displaying sales reports.
> Refunding and voiding documents.

On this course you will learn how to:
> Use the graphical environment of Altéa Reservation
Desktop Web (ARDW).
> Improve customer service with best practices.

This course covers the following topics:
> Understanding the ARDW environment and
architecture.
> Requesting an availability, informative
pricing, schedule and timetable display.
> Creating a Passenger Name Record (PNR).
> Modifying a PNR and interpreting its history.
> Working with Queues.
> Displaying fare information and pricing PNRs.
> Issuing, revalidating and reissuing e-tickets.
> Issuing, reissuing and managing EMDs.
> Displaying sales reports.
> Refunding and voiding documents.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 5 days English Certification No Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline help desk agents.

> Airline trainers.

> Airline reservation and ticketing agents.

Things you need for this course
Prework: 
> To ensure that you are familiar with ARD Web before
attending the training, we recommend you complete the
following e-learning (3 hours):

Altea Reservation Desktop Web awareness (3 hours)

 

> If you need to learn cryptic commands you should also
complete the following e-Learning:

Altea Reservation and Ticketing (Cryptic) (3h)

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

How the course is organised
> 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: May 2025
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e-Learning
Amadeus Revenue Accounting
As a revenue analyst, learn about tracking your passenger sales revenue in real-time to collect revenues faster and
improve cash flow. 

In this course, you will learn:
> What is a passenger revenue accounting system?
> How to read events for a ticket
> What is a task?
> What is RA Document View
> How to handle sale tasks
> How to handle accounting tasks
> How to capture handwritten documents
> How to identify coupon refund types
> How to issue a refund manually

Through a set of interactive e-learning lessons learn
what passenger revenue accounting is, what the
revenue accounting structure is, what an event is, what
the task flow is, how to interpret a document, when sale
tasks are raised, how to verify accounting rules, how to
capture paper documents, what the Undo-Redo
accounting feature is using Amadeus Revenue
Accounting (ARA).

In this course, you will learn:
> What is a passenger revenue accounting system?
> How to read events for a ticket
> What is a task?
> What is RA Document View
> How to handle sale tasks
> How to handle accounting tasks
> How to capture handwritten documents
> How to identify coupon refund types
> How to issue a refund manually

Through a set of interactive e-learning lessons learn
what passenger revenue accounting is, what the
revenue accounting structure is, what an event is, what
the task flow is, how to interpret a document, when sale
tasks are raised, how to verify accounting rules, how to
capture paper documents, what the Undo-Redo
accounting feature is using Amadeus Revenue
Accounting (ARA).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour + 10 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Sales & Marketing Agents, Trainers

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Revenue Accounting Certification

[Instructor-Led]   

How the course is organised
There are nine mandatory e-learning lessons.
After completion, there is an instructor-led session available to
request an enrolment. Finally, there are user guides available
for download.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablette.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.
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Instructor-Led
Amadeus Revenue Accounting - Interline Auditing
This course explains how to operate Interline Auditing Tool. This module, part of Amadeus Revenue Accounting,
enables the operating carrier to audit the fare collected by the validating carrier, and to decide which fare (e.g.,
Lowest Applicable Fare) will be used to bill the validating carrier. 

On this course you will learn how to:
> Determine whether the fares collected by the
validating carrier are accurate.
> Provide the fare elements of the lowest applicable
fare for proration and outward billing in case the
collected amount was inaccurate.

This course covers the following topics:
> Eligibility
> Interline Auditing process
> Proration error task

On this course you will learn how to:
> Determine whether the fares collected by the
validating carrier are accurate.
> Provide the fare elements of the lowest applicable
fare for proration and outward billing in case the
collected amount was inaccurate.

This course covers the following topics:
> Eligibility
> Interline Auditing process
> Proration error task

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 0.5 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines migrating to Amadeus Revenue Accounting
including the Interline Auditing Tool.

> Revenue accounting agents and subject matter experts.

> Business Process Outsourcing providers.

 

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Amadeus Revenue Accounting Certification.

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Revenue Accounting Certification

[Instructor-Led] 

> Amadeus Revenue Accounting - Proration Optimiser

[Instructor-Led]   

How the course is organised
> 0.5 day of Interline Auditing training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Revenue Accounting - Proration Optimiser
This course explains how to operate the Proration Optimiser Tool. This module, part of Amadeus Revenue
Accounting, allows airlines to monitor the performance of partnership agreements (e.g., Special Proration
Agreements and Multilateral Prorate Agreements) and provides decision support for setting specific interline
parameters.

On this course you will learn how to:
> Optimise your revenue generated by SPA agreements
and Provisos.
> Analyze in advance the anticipated revenue of a new
SPA.
> Compare it against MPA and/or an existing SPA.
> Find the optimal Provisos to maximize your revenues.

 

This course covers the following topics:
> Prortation Optimiser
> SPA simulation
> Proviso Optimization

 

 

On this course you will learn how to:
> Optimise your revenue generated by SPA agreements
and Provisos.
> Analyze in advance the anticipated revenue of a new
SPA.
> Compare it against MPA and/or an existing SPA.
> Find the optimal Provisos to maximize your revenues.

 

This course covers the following topics:
> Prortation Optimiser
> SPA simulation
> Proviso Optimization

 

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 0.5 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines migrating to Amadeus Revenue Accounting
including the Proration Optimiser Tool module

> Revenue accounting agents and subject matter experts

> Business Process Outsourcing providers

 

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Amadeus Revenue Accounting Certification.

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Revenue Accounting Certification

[Instructor-Led] 

> Amadeus Revenue Accounting - Interline Auditing

[Instructor-Led]   

How the course is organised
> 0.5 day of training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:
 learning@amadeus.com

> Last update: September 2025
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Instructor-Led
Amadeus Revenue Accounting Certification
This course explains how to configure and operate the Amadeus Revenue Accounting baseline modules, as a
solution for real-time revenue recognition during all document life cycles (from sales to usage and interline billing).
You will practice using hands-on exercises leading to a certification test.

On this course you will learn how to: 
> Understand integrated ARA architecture in Altéa and
its main core modules.
> Work on tasks related to each module.
> Set up ABR rules related to ARA baseline modules.
> Apply best practices for an effective configuration.

This course covers the following topics:
> Accounting
> Sales
> Taxes
> Usage
> Exchange and refund
> Agency Memo
> Task handling module
> Online reporting
> GSA commission 
> Codeshare
> Proration
> Interline
> FIM 

On this course you will learn how to: 
> Understand integrated ARA architecture in Altéa and
its main core modules.
> Work on tasks related to each module.
> Set up ABR rules related to ARA baseline modules.
> Apply best practices for an effective configuration.

This course covers the following topics:
> Accounting
> Sales
> Taxes
> Usage
> Exchange and refund
> Agency Memo
> Task handling module
> Online reporting
> GSA commission 
> Codeshare
> Proration
> Interline
> FIM 

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 10 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines migrating to Amadeus Revenus Accounting

> Revenue accounting airline agents, subject-matter experts.

> Business Process Outsourcing providers.

 

Things you need for this course
Pre-requisite: 
> Familiarity with airline business processes.

> Practical knowledge of ticketing processes.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (3 hours):

Altéa Reservation and Ticketing (Cryptic) awareness
Amadeus Revenue Accounting awareness

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Sales Auditing Certification [Instructor-Led] 

> Amadeus Revenue Accounting - Proration Optimiser

[Instructor-Led]   

How the course is organised
> 10 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: July 2025
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Instructor-Led
Amadeus Revenue Accounting Rules Filing
This course helps you to explain and operate the Accounting Rules Filing module of Amadeus Revenue Accounting.
This one-week course does not include a certification test.

 On this course you will learn how to: 
> Identify Accounting module architecture, processes
and rules mechanisms in Amadeus Revenue
Accounting.
> Set up Amadeus Business Rules (ABR) related to
each use case (i.e transaction) in Amadeus Revenue
Accounting.
> File accounting rules for each use case in Amadeus
Revenue Accounting.
> Apply best practices for accounting ABR rules filing.

This course covers the following topics and use cases:
> Overview of Accounting architecture and rules
mechanism

Amadeus Business Rules filing use cases :
> Sales
> Refund
> Exchange
> Flown
> FCS
> Expiration
> Agency Memo
> GSA commission 
> Codeshare
> Interline
> FIM

 On this course you will learn how to: 
> Identify Accounting module architecture, processes
and rules mechanisms in Amadeus Revenue
Accounting.
> Set up Amadeus Business Rules (ABR) related to
each use case (i.e transaction) in Amadeus Revenue
Accounting.
> File accounting rules for each use case in Amadeus
Revenue Accounting.
> Apply best practices for accounting ABR rules filing.

This course covers the following topics and use cases:
> Overview of Accounting architecture and rules
mechanism

Amadeus Business Rules filing use cases :
> Sales
> Refund
> Exchange
> Flown
> FCS
> Expiration
> Agency Memo
> GSA commission 
> Codeshare
> Interline
> FIM

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 5 days English Advanced Yes No

Is this the course for you?
This course is for:
> Airline staff who want to get familiar with Amadeus Revenue
Accounting Rules Filing but who will not use or administrate it
on a daily basis.

> Revenue accounting airline agents, and subject-matter
experts.

> Business Process Outsourcing providers.

> Implementation managers, and product managers.

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Amadeus Revenue Accounting Certification.

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Revenue Accounting Certification

[Instructor-Led]   

How the course is organised
> 5 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> This course is chargeable as non baseline.

> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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e-Learning
Amadeus Revenue Availability With Active Valuation
As an airline agent, learn how to use boost your sales and  bookability  by using the various functionalities, such as
a married segment, and several yield strategies available in Amadeus Revenue Availability with Active Valuation
(RAAV).

In this course, you will learn:
> What is revenue management, availability and
optimization?
> What Amadeus products are involved in the revenue
optimization process.
> How to distribute seat availability.
> What is the difference between basic and advanced
inventory controls?
> What is the Availability Decision Support tool?
> What is active valuation, yield and bid price?
> What is married segment control?
> How to use a segment strategy.
> How to use an N/AVS strategy.
> How to use a proration srategy.
> How to use an O&D tactical strategy.

Through a set of interactive lessons, learn how to
calculate revenue availability, retrieve and adjust yield
in Altéa Inventory (INV), identify different types of bid
price, how yield works with bid price, and how to use the
various active valuation strategies using Amadeus
Revenue Availability with Active Valuation (RAAV). 

In this course, you will learn:
> What is revenue management, availability and
optimization?
> What Amadeus products are involved in the revenue
optimization process.
> How to distribute seat availability.
> What is the difference between basic and advanced
inventory controls?
> What is the Availability Decision Support tool?
> What is active valuation, yield and bid price?
> What is married segment control?
> How to use a segment strategy.
> How to use an N/AVS strategy.
> How to use a proration srategy.
> How to use an O&D tactical strategy.

Through a set of interactive lessons, learn how to
calculate revenue availability, retrieve and adjust yield
in Altéa Inventory (INV), identify different types of bid
price, how yield works with bid price, and how to use the
various active valuation strategies using Amadeus
Revenue Availability with Active Valuation (RAAV). 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 hours English Fundamentals No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Inventory / Revenue Managers, Reservation Agents, Space
Controllers / SKD Managers, Trainers

This course helps you use
> Amadeus Revenue Availability With Active Valuation (RAAV) 
 

How the course is organised
There are 15 mandatory e-learning lessons. After completion,
there is a mandatory online test to assess your learning. Finally,
there are multiple user guides available for download.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablette.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

The last few details...
Last update: December 2025
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e-Learning
Amadeus Revenue Integrity
As an analyst, learn how Revenue Integrity enforces airline booking policy and minimises speculative booking
practices and therefore reduces distribution costs from non-productive bookings and maximises available
inventory for travellers ready to purchase tickets.

On this course, you will learn: 
> How to get started with Revenue Integrity Desktop
> What are the new Revenue Integrity Desktop
changes?
> How to use the Revenue Integrity search engine
> How to use the rule editor to manage business rules
> How to work with Amadeus Time Limits
> How to work with Group Time Limits

Through a set of interactive e-Learning lessons, how to
manage Amadeus Time Limits (ATL), how Group Time
Limits (GTL) processes a group PNR, how to create
business rules, and how to read logs using Amadeus
Revenue Integrity (ARI).

On this course, you will learn: 
> How to get started with Revenue Integrity Desktop
> What are the new Revenue Integrity Desktop
changes?
> How to use the Revenue Integrity search engine
> How to use the rule editor to manage business rules
> How to work with Amadeus Time Limits
> How to work with Group Time Limits

Through a set of interactive e-Learning lessons, how to
manage Amadeus Time Limits (ATL), how Group Time
Limits (GTL) processes a group PNR, how to create
business rules, and how to read logs using Amadeus
Revenue Integrity (ARI).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour + 20 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Business & Projects Managers, Fare Filing
Agents, Help Desk & Support Agents, Inventory / Revenue
Managers, Reservation Agents, Ticketing Agents, Trainers

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW) 

> Amadeus Revenue Integrity   

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.
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Instructor-Led
Amadeus Rewards
The focus of this training course is the administration of Amadeus Rewards conversion rules. Those rules are
administered through the Cash to Miles conversion module which is part of the Amadeus FareXpert filing platform.
Conversion rates defined in these rules can convert currency based fare or Ancillary Service amounts into Miles /
Points. Then airline frequent flyer members can book air travel and choose to settle the price of a ticket or an
Ancillary Service in currency, in Miles, or a combination of both.

 On this course you will learn how to:
> Distinguish between 'Flight Rewards' (full redemption)
and 'Cash & Miles' flows.
> Access the FareXpert filing platform.
> Launch the FareXpert based Cash to Miles
conversion rules module.
> Administer Cash to Miles conversion rules.
> Create new rules or duplicate existing rules.
> Differentiate conversion rules targeting commercial
fares versus marginal fares.
> Configure rules with Cash boundaries.
> Work with Point Offsets (static charts).
> Update exisiting rules with effective and
discontinuation dates.
> Grant adhoc Miles discounts.
> Differentiate the conversion logic of fares, Ancillary
Services and Taxes.

This course covers the following topics: 
> Overview and terminology of Amadeus Rewards flow
solutions (Flight Rewards, Cash & Miles).
> How to access the FareXpert Cash to Miles
conversion rules module.
> How to administer Cash to Miles conversion
rulesbased on real-life use cases.
> How to differentiate conversion rules targeting
revenue fares from rules targeting full redemption fares.

 

 On this course you will learn how to:
> Distinguish between 'Flight Rewards' (full redemption)
and 'Cash & Miles' flows.
> Access the FareXpert filing platform.
> Launch the FareXpert based Cash to Miles
conversion rules module.
> Administer Cash to Miles conversion rules.
> Create new rules or duplicate existing rules.
> Differentiate conversion rules targeting commercial
fares versus marginal fares.
> Configure rules with Cash boundaries.
> Work with Point Offsets (static charts).
> Update exisiting rules with effective and
discontinuation dates.
> Grant adhoc Miles discounts.
> Differentiate the conversion logic of fares, Ancillary
Services and Taxes.

This course covers the following topics: 
> Overview and terminology of Amadeus Rewards flow
solutions (Flight Rewards, Cash & Miles).
> How to access the FareXpert Cash to Miles
conversion rules module.
> How to administer Cash to Miles conversion
rulesbased on real-life use cases.
> How to differentiate conversion rules targeting
revenue fares from rules targeting full redemption fares.

 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines in PSS or standalone migration.

> Airline Fares and Pricing analysts, Loyalty Management
System administrators, Digital touchpoint administrators.

Things you need for this course
Pre-requisite: 
> Basic understanding of Amadeus Rewards flow solutions.

> Basic understanding of Fares & Pricing.

> An implemented RefX online booking flow. This course is
only suitable for airlines who have migrated. If your online
flows are still based on e-Retail DX and the migration to RefX is
not yet planned, then refer to our 'Digital Awards' training
course.

This course helps you use
> Amadeus FareXpert 

> Loyalty Management System   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: January 2025
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Instructor-Led
Amadeus Sales Auditing Certification
This course explains how to configure and operate the Amadeus Sales Auditing module (ASA). This optional
Amadeus Revenue Accounting module audits all sales, exchanges, and refund transactions performed by
Amadeus, other GDS travel agencies, airline ATO/CTOs or GSA sales agents.
You will practice using hands-on exercises leading to a certification test.

On this course you will learn how to:
> Understand and use the ASA module.
> Learn how to set up its Amadeus Business Rules to
meet your business requirements.
> Work on ASA-related tasks.
> Work on reports generated by the ASA module.

This course covers the following topics:
> Audit of issuance, exchange and refund transactions
(Audit of Tickets and EMDs).
> Sales Audit Amadeus Business Rules.
> Sales Audit tasks and related Agency Memo creation.
> Sales Audit reports

On this course you will learn how to:
> Understand and use the ASA module.
> Learn how to set up its Amadeus Business Rules to
meet your business requirements.
> Work on ASA-related tasks.
> Work on reports generated by the ASA module.

This course covers the following topics:
> Audit of issuance, exchange and refund transactions
(Audit of Tickets and EMDs).
> Sales Audit Amadeus Business Rules.
> Sales Audit tasks and related Agency Memo creation.
> Sales Audit reports

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 3 days English Certification Yes No

Is this the course for you?
This course is for:
> Airlines migrating to Amadeus Revenue Accounting
including the Sales Auditing module.

> Revenue accounting and Sales Auditing airline agents,
subject-matter experts.

> Business Process Outsourcing providers.

 

Things you need for this course
Pre-requisite: 
Have successfully passed the following course:

> Amadeus Revenue Accounting Certification.

This course helps you use
> Amadeus Revenue Accounting   

Related courses
> Amadeus Revenue Accounting Certification

[Instructor-Led]   

How the course is organised
> 3 days of training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customized session, please contact:
 learning@amadeus.com

> Last update: September 2025
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e-Learning
Amadeus Security Management
As a security administrator, control user authentication and access control across all Amadeus systems.

On this course, you will learn:
> What is Amadeus Security Management
> How to create user access
> How to remove user access
> How to manage user access
> What are partnerships
> How to create partnerships
> How to remove partnerships

Through a set of interactive videos learn about user
access, user responsibility, partnerships with other
organisations by using Amadeus Security Management
(ASM). 

On this course, you will learn:
> What is Amadeus Security Management
> How to create user access
> How to remove user access
> How to manage user access
> What are partnerships
> How to create partnerships
> How to remove partnerships

Through a set of interactive videos learn about user
access, user responsibility, partnerships with other
organisations by using Amadeus Security Management
(ASM). 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 hour + 10 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines, Ground Handlers

In particular, those working in:
Administrators, Help Desk & Support Agents, Security
Administrators, Trainers

This course helps you use
> Amadeus Security Management (ASM)   

Related courses
> Local Security Management [e-Learning] 

> Amadeus Office Management [e-Learning]   

How the course is organised
7 interactive lessons with a duration of 1 hour and 10 minutes.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

The last few details...
To get access to ASM, you will need to complete a 4-days
instructor-led training and successfully pass the test.
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Instructor-Led
Amadeus Security Management Certification for
Altéa Airlines
This course explains how to use the Amadeus Security Management (ASM) and provide authentication, access
control and security administration across Amadeus products.
You will practice using hands-on exercises leading to a certification test.

On this course, you will learn how to:
> Navigate through the ASM application.
> Define the security setup for an airline.
> Identify and apply security elements to allow access
to applications

This course covers the following topics:
> Organisation and User Management
> Navigating ASM.
> Access Rights management.
> Managing partnerships between organisations.
> Deleting roles, offices and organisation units.
> Practical exercises.

On this course, you will learn how to:
> Navigate through the ASM application.
> Define the security setup for an airline.
> Identify and apply security elements to allow access
to applications

This course covers the following topics:
> Organisation and User Management
> Navigating ASM.
> Access Rights management.
> Managing partnerships between organisations.
> Deleting roles, offices and organisation units.
> Practical exercises.

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 4 days English Certification Yes Yes

Is this the course for you?
This course is for:
> Airlines in PSS migration

> Airline security administrators

Things you need for this course
Pre-requisite: 
> Familiarity with airline business processes and task
distribution.

Prework: 
> To ensure that you are familiar with our products before
attending the training, we recommend you complete the
following e-learning (1 hour):

Amadeus Security Management awareness

 

> Complete the Local Security Management e-Learning
(30mins) if your airline uses it.

This course helps you use
> Amadeus Security Management (ASM)   

Related courses
> Amadeus Reservation and Ticketing Help Desk for Airlines

[Instructor-Led] 

> Amadeus Office Management Certification for Airlines

[Instructor-Led]   

How the course is organised
> 4 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
 learning@amadeus.com

> Last update: August 2025
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Instructor-Led
Amadeus Security Management for Altéa Airlines
Advanced
This course builds upon the ASM certification course by exploring complex scenarios for effective problem solving
with the use of hands-on exercises related to security management, access rights administration, product
activation, and industry best practices.

In this course, you will learn:
> Assess real scenarios when a security administrator
needs to take action.
> Identify mandatory security configurations required
for airlines.
> Utilize massive tool and reporting dashboard.
> Manage security data.
> Manage users.
> Find permissions for product activation.
> Handle access rights allocation. 
> Apply best practices for ground handling operations.

This course covers the following topics:
> User Management
> Application Management
> Data Management

In this course, you will learn:
> Assess real scenarios when a security administrator
needs to take action.
> Identify mandatory security configurations required
for airlines.
> Utilize massive tool and reporting dashboard.
> Manage security data.
> Manage users.
> Find permissions for product activation.
> Handle access rights allocation. 
> Apply best practices for ground handling operations.

This course covers the following topics:
> User Management
> Application Management
> Data Management

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Advanced Yes No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Help Desk & Support Agents, Operations
Managers, Security Administrators, Trainers

Things you need for this course
Pre-requisite: 
Have successfully passed the course below:

> Amadeus Security Management Certification for Altéa

Airlines

This course helps you use
> Amadeus Security Management (ASM)   

Related courses
> Amadeus Security Management Certification for Altéa

Airlines [Instructor-Led]   

How the course is organised
> 3 Days training 

This course is also available in
English

What equipment do you need?
View our instructor-led requirements.

 

The last few details...
> To schedule a customized session, please contact:
learning@amadeus.com

> Last update June 2025
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Instructor-Led
Amadeus Security Management for Altéa Flight
Management Operations
This course explains how to use Amadeus Security Management (ASM) to manage authentication, access control
and security administration across Amadeus products. The course includes hands-on exercises focused on
configuring access rights specifically for Altéa Departure Control - Flight Management.

On this course, you will learn how to:
> Navigate Amadeus Security Management.
> Define the security setup for an airline.
> Identify and apply security elements to Altéa
Departure Control - Flight Management user access.

This course covers the following topics:
> Managing organisations and users
> Navigating ASM.
> Managing access rights.
> Managing partnerships between organisations.
> Deleting roles, offices, and organisation units.
> Completing practical exercises.

On this course, you will learn how to:
> Navigate Amadeus Security Management.
> Define the security setup for an airline.
> Identify and apply security elements to Altéa
Departure Control - Flight Management user access.

This course covers the following topics:
> Managing organisations and users
> Navigating ASM.
> Managing access rights.
> Managing partnerships between organisations.
> Deleting roles, offices, and organisation units.
> Completing practical exercises.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 days English Fundamentals Yes Yes

Is this the course for you?
This course is for:
> Airline system security administrators

Things you need for this course
Pre-requisite: 
> Familiarity with airline business processes and load control
activities

Prework: 
To ensure that you are familiar with our products before
attending this course, we recommend you complete the
following e-learning:

> Amadeus Security Management awareness (1 hour)

> Amadeus Local Security Management awareness (30 mins.,
if your airline uses it)

This course helps you use
> Amadeus Security Management (ASM)   

Related courses
> Amadeus Office Management Certification for Airlines

[Instructor-Led]   

How the course is organised
> 3 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: January 2026
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Instructor-Led
Amadeus Smart Flows
This course explains how to create, modify and share Smart Flows using both command-based and language
mode.

In this course, you will learn how to:
>  Create a Smart Flow using Command-based mode.
>  Create a Smart Flow using Advance language mode.

This course covers the following topics:
> Smart Flows Overview
> Smart Flows Language
> Creating Smart Flows using Command-based mode.
> Creating Smart Flows using Advance language mode.
> Sharing Smart Flows.

In this course, you will learn how to:
>  Create a Smart Flow using Command-based mode.
>  Create a Smart Flow using Advance language mode.

This course covers the following topics:
> Smart Flows Overview
> Smart Flows Language
> Creating Smart Flows using Command-based mode.
> Creating Smart Flows using Advance language mode.
> Sharing Smart Flows.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 2 days English Fundamentals Yes Yes

Is this the course for you?
This course is for:
> Business Analysts

> Testers

> Trainers

Things you need for this course
Pre-requisite: 
> Knowledge of Amadeus Reservation and Ticketing cryptic
commands is mandatory.

> A basic understanding of scripting methodology.

> A basic understanding of Regular Expressions.

> A basic understanding of HTML.

Prework: 
> Complete "Altéa Reservation and Ticketing (Cryptic)

Awareness" learning path.

> Complete "How to create a smart flow using

command-based mode" e-learning lesson.

> Complete "How to work with shared smart flows" e-learning
lesson.

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW)   

How the course is organised
> 2 days training

This course is also available in
English

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: July 2024
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Instructor-Led
Amadeus Traveler DNA - Customer Knowledge
Center (CKC)
This course provides an overview of Amadeus Traveler DNA solution focusing on the Customer Knowledge Center
(CKC). With practical hands-on exercises, you will learn how to handle Traveler DNA profiles retrieval and
maintenance in 360°View as well as how to create and maintain segments in Segmentation Studio.

On this course, you will learn how to:
> Log in to Amadeus Travel DNA via Amadeus Anytime
Merchandising & Travel DNA application.
> Manage and customize passenger profiles.
> Define and maintain passenger behavior segments.

This course covers the following topics:
> Traveler DNA product overview
> Traveler DNA product scope
> Traveler DNA profiles
> 360°View application
> Traveler DNA profiles maintenance
> Segments
> Segmentation Studio
> Segments maintenace

On this course, you will learn how to:
> Log in to Amadeus Travel DNA via Amadeus Anytime
Merchandising & Travel DNA application.
> Manage and customize passenger profiles.
> Define and maintain passenger behavior segments.

This course covers the following topics:
> Traveler DNA product overview
> Traveler DNA product scope
> Traveler DNA profiles
> 360°View application
> Traveler DNA profiles maintenance
> Segments
> Segmentation Studio
> Segments maintenace

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes No

Is this the course for you?
This course is for:
> Airlines using Amadeus Altéa PSS.

> Airline administrators dealing with system database,
marketing, customer relation, and customer services.

Things you need for this course
Pre-requisite: 
> Basic understanding/knowledge about PNRs

> High-level knowledge of airline business processes (e.g.
reservation & ticketing, passenger acceptance, disruption)

> High-level knowledge of Altéa products (e.g. Reservation,
Inventory, Process Customer Value, Departure Control -
Customer Management)

Related courses
> Amadeus Traveler DNA - Personalized Servicing (PS)

[Instructor-Led]   

How the course is organised
> 1 day of training (or two 3.5-hour sessions) 

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: August 2025
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Instructor-Led
Amadeus Traveler DNA - Personalized Servicing (PS)
This course provides an overview of the Amadeus Traveler DNA solution using the Personalized Servicing (PS)
module. Building on Customer Knowledge Center (CKC) module knowledge, it covers Traveler DNA features that
interface with other business processes and multiple customer touchpoints. Through practical hands-on exercises,
you will create and maintain alert campaigns, and review behaviour segments for alert campaigns that influence
customer interactions.

On this course, you will learn how to:
>  Create and manage Traveler DNA alert campaigns to
enhance customer touchpoints.
> 

 Handle alerts at various touchpoints and identify how
Traveler DNA reports the results.
>  Leverage additional features of Traveler DNA in other
business processes and across customer touchpoints
to enhance customer recognition.

 

 

This course covers the following topics:
> Product overview
> Personalized servicing
> Campaign and campaign maintenance
> Features interfacing with other business processes
and various customer touchpoints
> Alert campaign
> Alert handling on customer touchpoints

On this course, you will learn how to:
>  Create and manage Traveler DNA alert campaigns to
enhance customer touchpoints.
> 

 Handle alerts at various touchpoints and identify how
Traveler DNA reports the results.
>  Leverage additional features of Traveler DNA in other
business processes and across customer touchpoints
to enhance customer recognition.

 

 

This course covers the following topics:
> Product overview
> Personalized servicing
> Campaign and campaign maintenance
> Features interfacing with other business processes
and various customer touchpoints
> Alert campaign
> Alert handling on customer touchpoints

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 1 day English Fundamentals Yes Yes

Is this the course for you?
This course is for:
> Airlines using Amadeus Altéa PSS.

> Airline administrators dealing with system database,
marketing, customer relations, and customer services.

Things you need for this course
Pre-requisite: 
> Basic understanding/knowledge about PNRs

> High-level knowledge of airline business processes (e.g.
reservation & ticketing, passenger acceptance, disruption)

> High-level knowledge of Altéa products (e.g. Reservation,
Inventory, Process Customer Value, Departure Control -
Customer Management)

Prework: 
> Attend Traveler DNA - Customer Knowledge Center (CKC)
training

Related courses
> Amadeus Traveler DNA - Customer Knowledge Center

(CKC) [Instructor-Led]   

How the course is organised
> 1 day of training (or two 3.5-hour sessions) 

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please
contact: learning@amadeus.com

> Last update: June 2025
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Instructor-Led
FareXpert Negotiated Fares
This course explains how to use Amadeus FareXpert Negotiated Fares to define net and selling fares, and assign
these fares to agents for display, pricing and ticketing in distribution systems.

In this course, you will learn how to:
> Create and modify single negotiated fares.
> Create and modify global negotiated fares.

This course covers the following topics:
> Creating and modifying rule definitions with net
selling / net fare only options.
> Creating and updating vendor aggregates.
> Selecting a rule and setting the distribution and
ticketing options.
> Choosing a rule and creating rule conditions.
> Selecting a rule and setting its booking code
exceptions.
> Setting up routings.
> Selecting a rule, routing and creating the fares.
> Setting up and maintaining location aggregates.
> Creating fares using global update.
> Modifying the fares utilising global update.
> Discontinuing fares through global update.
> This course does not cover Voluntary Changes
(CAT31) nor Voluntary Refund (CAT33).

In this course, you will learn how to:
> Create and modify single negotiated fares.
> Create and modify global negotiated fares.

This course covers the following topics:
> Creating and modifying rule definitions with net
selling / net fare only options.
> Creating and updating vendor aggregates.
> Selecting a rule and setting the distribution and
ticketing options.
> Choosing a rule and creating rule conditions.
> Selecting a rule and setting its booking code
exceptions.
> Setting up routings.
> Selecting a rule, routing and creating the fares.
> Setting up and maintaining location aggregates.
> Creating fares using global update.
> Modifying the fares utilising global update.
> Discontinuing fares through global update.
> This course does not cover Voluntary Changes
(CAT31) nor Voluntary Refund (CAT33).

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes - pass mark: 85% 4 days English Certification Yes No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Fare Filing Agents, Help Desk & Support Agents, Ticketing
Agents, Trainers

Things you need for this course
Pre-requisite: 
> You need a basic knowledge of fares and fare filing and
Amadeus PNR creation.

This course helps you use
> Amadeus FareXpert   

Related courses
> Amadeus FareXpert Dynamic Fares [Instructor-Led]   

How the course is organised
> 4 days training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> This information was last updated January 2025.
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Instructor-Led
Group bookings in Altéa Reservation Desktop Web
This course explains how to process groups bookings in Altéa Reservation Desktop Web.

On this course, you will learn how to:
> Assess the best functionalities to create and manage
group bookings.
> Use automatic pricing for group booking.
> Create a manual TST entry to price the itinerary of a
group booking.
> Manage payment and issue tickets from a group PNR.

 

This course covers the following topics:
> Create the itinerary for a group PNR. 
> Manually update passenger names in a group PNR.
> Manage seats in a group PNR (assigned and
non-assigned).
> Import and update a passenger list from a
spreadsheet.
> Price a group PNR (automatic pricing and manual
TST creation).
> Issue tickets in a group PNR.

On this course, you will learn how to:
> Assess the best functionalities to create and manage
group bookings.
> Use automatic pricing for group booking.
> Create a manual TST entry to price the itinerary of a
group booking.
> Manage payment and issue tickets from a group PNR.

 

This course covers the following topics:
> Create the itinerary for a group PNR. 
> Manually update passenger names in a group PNR.
> Manage seats in a group PNR (assigned and
non-assigned).
> Import and update a passenger list from a
spreadsheet.
> Price a group PNR (automatic pricing and manual
TST creation).
> Issue tickets in a group PNR.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 3 hours + 0.5 day English Fundamentals Yes No

Is this the course for you?
This course is for:
Airline users who will perform group bookings in Altéa
Reservation Desktop Web

Things you need for this course
Pre-requisite: 
> A basic knowledge of Passenger Name Records (PNR).

> Complete the following e-Learning lesson (3 hrs): Altéa

Reservation and Ticketing (Cryptic) awareness

This course helps you use
> Altéa Reservation Desktop Web (ARDW)   

Related courses
> Amadeus Reservation and Ticketing Web Certification for

New Users [Instructor-Led] 

> Amadeus Reservation and Ticketing Web

Certification-Conversion from Amadeus Cryptic to Graphic

[Instructor-Led]   

How the course is organised
>  3 hrs of e-Learning
>  0.5 day of virtual training

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> Last update: June 2025
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e-Learning
Inconsistent Journey Management
As an analyst, learn how to forecast and manage revenue in real-time with greater accuracy and therefore reduce
distribution costs from non-productive bookings using an internet browser.

On this course, you will learn: 
> What are the Duplicate Segment Manager
configurations?
> How to navigate Duplicate Segment Manager
> How to interpret Duplicate Segment Manager logs
> How to create Duplicate Segment Manager business
rules
> How Duplicate Segment Manager processes a PNR

Through a set of e-Learning lessons, learn what the
Duplicate Segment Manager configurations are, how to
read and interpret logs, how non-compliant PNRs are
detected and which segments will be targeted for
action, and how to create business rules using
Amadeus Revenue Integrity (ARI).

On this course, you will learn: 
> What are the Duplicate Segment Manager
configurations?
> How to navigate Duplicate Segment Manager
> How to interpret Duplicate Segment Manager logs
> How to create Duplicate Segment Manager business
rules
> How Duplicate Segment Manager processes a PNR

Through a set of e-Learning lessons, learn what the
Duplicate Segment Manager configurations are, how to
read and interpret logs, how non-compliant PNRs are
detected and which segments will be targeted for
action, and how to create business rules using
Amadeus Revenue Integrity (ARI).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 0 hour + 45 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Fare Filing Agents, Help Desk & Support
Agents, Reservation Agents, Ticketing Agents, Trainers

This course helps you use
> Amadeus Revenue Integrity   

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.
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e-Learning
Local Security Management
As a local security administrator, control user authentication and access control on your Amadeus product.

On this course, you will learn:
> What is Local Security Management?
> How to create users in Local Security Management
> How to manage users in Local Security Management
> How to register devices for Digital DNA authentication
> How to create agreements in Local Security
Management
> What is guest authentication?

Through a set of interactive e-Learning lessons, learn
about user access, Digital DNA authentication, and
creating agreements using Local Security Management
(LSM).

On this course, you will learn:
> What is Local Security Management?
> How to create users in Local Security Management
> How to manage users in Local Security Management
> How to register devices for Digital DNA authentication
> How to create agreements in Local Security
Management
> What is guest authentication?

Through a set of interactive e-Learning lessons, learn
about user access, Digital DNA authentication, and
creating agreements using Local Security Management
(LSM).

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 30 days English Awareness No No

Is this the course for you?
This course is for:
Airlines, Ground Handlers

In particular, those working in:
Administrators, Help Desk & Support Agents, Security
Administrators, Trainers

This course helps you use
> Amadeus Security Management (ASM)   

Related courses
> Amadeus Office Management [e-Learning]   

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet.

> A high-speed internet connection (> 1MB).

> The Google Chrome browser or alternatively the Microsoft
Edge browser.

> An Amadeus login (LSS), organization ID (IATA code) and
password.

The last few details...
To get access to ASM, you will need to complete a 4-days
instructor-led training and successfully pass the test.
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e-Learning
Seatmap Management
As a ground handler, create seat maps for flights using the Altéa ad hoc solution. 

On this course, you will learn:
>  How to create a seat map using the Altéa ad hoc
solution.

 

Through an interactive video learn how to create a seat
map using Seatmap Management accessible in
Amadeus Application Launcher.

On this course, you will learn:
>  How to create a seat map using the Altéa ad hoc
solution.

 

Through an interactive video learn how to create a seat
map using Seatmap Management accessible in
Amadeus Application Launcher.

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 5 minutes English Awareness No No

Is this the course for you?
This course is for:
> Agents performing ground handling activities at the airport.

This course helps you use
> Altéa Departure Control - Customer Management (CM) 

> Altéa Departure Control - Flight Management (FM) 

> Amadeus Application Launcher   

How the course is organised
There is one interactive lesson with a duration of 5 minutes.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet. 

> A high-speed internet connection (> 1MB). 

> The Google Chrome browser or alternatively the Microsoft
Edge browser. 

> An Amadeus login (LSS), organization ID (IATA code) and
password. 
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e-Learning
Ticketing Configuration Manager
As a ticketing manager, learn how to regulate and control your ticketing agreements and conditions using a
graphical interface.

On this course, you will learn:
> What is TCM? 
> What is the Online application?
> How to identify an airline's preferences for e-ticket
display options.
> How to allow or restrict issuance of infant tickets.
> How to allow or disallow mandatory FOID at time of
issuance.
> What is the Interline sub-application?
> How to identify the interline agreements between a
validating carrier and an interline partner.
> How to identify an airline's distribution conditions for
specific GDS and countries.  

Through a set of interactive e-Learning videos learn
what is TCM and what are TCM's sub-applications, how
to identify rule types, how to modify rule conditions and
how to modify interline ticketing agreements using
Ticketing Configuration Manager (TCM). 

On this course, you will learn:
> What is TCM? 
> What is the Online application?
> How to identify an airline's preferences for e-ticket
display options.
> How to allow or restrict issuance of infant tickets.
> How to allow or disallow mandatory FOID at time of
issuance.
> What is the Interline sub-application?
> How to identify the interline agreements between a
validating carrier and an interline partner.
> How to identify an airline's distribution conditions for
specific GDS and countries.  

Through a set of interactive e-Learning videos learn
what is TCM and what are TCM's sub-applications, how
to identify rule types, how to modify rule conditions and
how to modify interline ticketing agreements using
Ticketing Configuration Manager (TCM). 

Certification: Duration: Language: Level: Pre-requisite: Prework:
No 30 minutes English Awareness No No

Is this the course for you?
This course is for:
Airlines

In particular, those working in:
Administrators, Help Desk & Support Agents, Reservation
Agents, Ticketing Agents, Trainers

This course helps you use
> Altéa Reservation Desktop Essential 

> Altéa Reservation Desktop Web (ARDW) 

> Amadeus Application Launcher   

How the course is organised
There are eight lessons with a duration of 30 minutes.

This course is also available in
English

What equipment do you need?
> A computer, laptop or tablet. 

> A high-speed internet connection (> 1MB). 

> The Google Chrome browser or alternatively the Microsoft
Edge browser. 

> An Amadeus login (LSS), organization ID (IATA code) and
password.   
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Instructor-Led
Training techniques for airline trainers
In this course Amadeus trainers will equip you with the right techniques to deliver efficient and engaging functional
training by using hands-on practice activities and real-time delivery exercises.

In this course you will learn how to:
> Share the Amadeus Trainer's Values.
> Find your inner trainer.
> Take care of your participants.

 This course covers the following topics:
> Becoming your company's ambassador.
> Examining the techniques of a trainer.
> Dealing with challenging situations and behaviours (
classroom and virtual).
> Designing an efficient evaluation system.
> Giving and receiving feedback.
> Analysing adults' methods of learning.
> Identifying the profiles of different participants.
> Preparing your training delivery.
> Discovering the Knowledge Management Ecosystem
(video).

In this course you will learn how to:
> Share the Amadeus Trainer's Values.
> Find your inner trainer.
> Take care of your participants.

 This course covers the following topics:
> Becoming your company's ambassador.
> Examining the techniques of a trainer.
> Dealing with challenging situations and behaviours (
classroom and virtual).
> Designing an efficient evaluation system.
> Giving and receiving feedback.
> Analysing adults' methods of learning.
> Identifying the profiles of different participants.
> Preparing your training delivery.
> Discovering the Knowledge Management Ecosystem
(video).

Certification: Duration: Language: Level: Pre-requisite: Prework:
Yes 2 days English Certification Yes No

Is this the course for you?
This course is for:
> Airlines in PSS migration.

> Subject Matter Experts who need to start delivering training
on Amadeus products.

> Experienced trainers wishing to refresh their skills.

Things you need for this course
Pre-requisite: 
Have successfully passed one of the courses below:

> ARD Web Certification for New Users
> Amadeus Amadeus Altéa Inventory Certification
> Amadeus Altéa DC-CM certification
> Amadeus Altéa DC-FM certification

How the course is organised
> 2 days training.

> During the course you will complete 2 hands-on practice
activities in classroom and deliver 1 training session of 20-30
minutes.

> You will receive constructive feedback on your delivery of
the training session.

What equipment do you need?
View our instructor-led requirements.

The last few details...
> To schedule a customised session, please contact:
learning@amadeus.com

> This course is available as classroom only.

> Last update: June 2025
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